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Legal Notices Product specifications are subject to change without notice and do not represent a commitment on the part of Avid Technology, Inc. The software described in this document is furnished under a license agreement. You can obtain a copy of that license by visiting Avid's Web site at www.avid.com. The terms of that license are also available in the product in the same directory as the software. The software may not be reverse assembled and may be used or copied only in accordance with the terms of the license agreement. It is against the law to copy the software on any medium except as specifically allowed in the license agreement. Avid products or portions thereof are protected by one or more of the following United States Patents: 4,970,663; 5,045,940; 5,267,351; 5,309,528; 5,355,450; 5,396,594; 5,440,348; 5,452,378; 5,467,288; 5,513,375; 5,528,310; 5,557,423; 5,568,275; 5,577,190; 5,584,006; 5,640,601; 5,644,364; 5,654,737; 5,715,018; 5,724,605; 5,726,717; 5,729,673; 5,745,637; 5,752,029; 5,754,851; 5,799,150; 5,812,216; 5,852,435; 5,584,006; 5,905,841; 5,929,836; 5,930,445; 5,946,445; 5,987,501; 6,016,152; 6,018,337; 6,023,531; 6,058,236; 6,061,758; 6,091,778; 6,105,083; 6,118,444; 6,128,001; 6,134,607; 6,137,919; 6,141,691; 6,198,477; 6,201,531; 6,223,211; 6,249,280; 6,269,195; 6,317,158; 6,317,515; 6,330,369; 6,351,557; 6,353,862; 6,357,047; 6,392,710; 6,404,435; 6,407,775; 6,417,891; 6,426,778; 6,477,271; 6,489,969; 6,512,522; 6,532,043; 6,546,190; 6,552,731; 6,553,142; 6,570,624; 6,571,255; 6,583,824; 6,618,547; 6,636,869; 6,665,450; 6,678,461; 6,687,407; 6,704,445; 6,747,705; 6,763,134; 6,766,063; 6,791,556; 6,810,157; 6,813,622; 6,847,373; 6,871,003; 6,871,161; 6,901,211; 6,907,191; 6,928,187; 6,933,948; 6,961,801; 7,043,058; 7,081,900; 7,103,231; 7,266,241; 7,280,117; D392,269; D396,853; D398,912. Other patents are pending. Avid products or portions thereof are protected by one or more of the following United States Patents: 4,970,663; 5,045,940; 5,267,351; 5,309,528; 5,355,450; 5,396,594; 5,440,348; 5,452,378; 5,467,288; 5,513,375; 5,528,310; 5,557,423; 5,577,190; 5,583,496; 5,584,006; 5,627,765; 5,640,601; 5,644,364; 5,654,737; 5,715,018; 5,719,570; 5,724,605; 5,726,717; 5,729,673; 5,745,637; 5,752,029; 5,754,851; 5,799,150; 5,812,216; 5,828,678; 5,842,014; 5,852,435; 5,999,406; 6,038,573; 6,061,758; 6,141,007; 6,211,869; 6,532,043; 6,546,190; 6,596,031; 6,636,869; 6,747,705; 6,763,523; 6,766,357; 6,813,622; 6,847,373; 7,081,900; D352,278; D372,478; D373,778; D392,267; D392,268; D392,269; D395,291; D396,853; D398,912. Other patents are pending. This document is protected under copyright law. An authorized licensee of Avid Media ComposerNewsCutterAvid Symphony Nitris may reproduce this publication for the licensee’s own use in learning how to use the software. This document may not be reproduced or distributed, in whole or in part, for commercial purposes, such as selling copies of this document or providing support or educational services to others. This document is supplied as a guide for Avid Media ComposerNewsCutter and NewsCutter XPAvid Symphony Nitris. Reasonable care has been taken in preparing the information it contains. However, this document may contain omissions, technical inaccuracies, or typographical errors. Avid Technology, Inc. does not accept responsibility of any kind for customers’ losses due to the use of this document. Product specifications are subject to change without notice.



Copyright © 2008 Avid Technology, Inc. and its licensors. All rights reserved.



The following disclaimer is required by Apple Computer, Inc.: APPLE COMPUTER, INC. MAKES NO WARRANTIES WHATSOEVER, EITHER EXPRESS OR IMPLIED, REGARDING THIS PRODUCT, INCLUDING WARRANTIES WITH RESPECT TO ITS MERCHANTABILITY OR ITS FITNESS FOR ANY PARTICULAR PURPOSE. THE EXCLUSION OF IMPLIED WARRANTIES IS NOT PERMITTED BY SOME STATES. THE ABOVE EXCLUSION MAY NOT APPLY TO YOU. THIS WARRANTY PROVIDES YOU WITH SPECIFIC LEGAL RIGHTS. THERE MAY BE OTHER RIGHTS THAT YOU MAY HAVE WHICH VARY FROM STATE TO STATE.



The following disclaimer is required by Sam Leffler and Silicon Graphics, Inc. for the use of their TIFF library: Copyright © 1988–1997 Sam Leffler Copyright © 1991–1997 Silicon Graphics, Inc. Permission to use, copy, modify, distribute, and sell this software [i.e., the TIFF library] and its documentation for any purpose is hereby granted without fee, provided that (i) the above copyright notices and this permission notice appear in all copies of the software and related documentation, and (ii) the names of Sam Leffler and Silicon Graphics may not be used in any advertising or publicity relating to the software without the specific, prior written permission of Sam Leffler and Silicon Graphics. THE SOFTWARE IS PROVIDED “AS-IS” AND WITHOUT WARRANTY OF ANY KIND, EXPRESS, IMPLIED OR OTHERWISE, INCLUDING WITHOUT LIMITATION, ANY WARRANTY OF MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE.
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IN NO EVENT SHALL SAM LEFFLER OR SILICON GRAPHICS BE LIABLE FOR ANY SPECIAL, INCIDENTAL, INDIRECT OR CONSEQUENTIAL DAMAGES OF ANY KIND, OR ANY DAMAGES WHATSOEVER RESULTING FROM LOSS OF USE, DATA OR PROFITS, WHETHER OR NOT ADVISED OF THE POSSIBILITY OF DAMAGE, AND ON ANY THEORY OF LIABILITY, ARISING OUT OF OR IN CONNECTION WITH THE USE OR PERFORMANCE OF THIS SOFTWARE.



The following disclaimer is required by the Independent JPEG Group: This software is based in part on the work of the Independent JPEG Group.



This Software may contain components licensed under the following conditions: Copyright (c) 1989 The Regents of the University of California. All rights reserved. Redistribution and use in source and binary forms are permitted provided that the above copyright notice and this paragraph are duplicated in all such forms and that any documentation, advertising materials, and other materials related to such distribution and use acknowledge that the software was developed by the University of California, Berkeley. The name of the University may not be used to endorse or promote products derived from this software without specific prior written permission. THIS SOFTWARE IS PROVIDED ``AS IS'' AND WITHOUT ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, WITHOUT LIMITATION, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE. Copyright (C) 1989, 1991 by Jef Poskanzer. Permission to use, copy, modify, and distribute this software and its documentation for any purpose and without fee is hereby granted, provided that the above copyright notice appear in all copies and that both that copyright notice and this permission notice appear in supporting documentation. This software is provided "as is" without express or implied warranty. Copyright 1995, Trinity College Computing Center. Written by David Chappell. Permission to use, copy, modify, and distribute this software and its documentation for any purpose and without fee is hereby granted, provided that the above copyright notice appear in all copies and that both that copyright notice and this permission notice appear in supporting documentation. This software is provided "as is" without express or implied warranty. Copyright 1996 Daniel Dardailler. Permission to use, copy, modify, distribute, and sell this software for any purpose is hereby granted without fee, provided that the above copyright notice appear in all copies and that both that copyright notice and this permission notice appear in supporting documentation, and that the name of Daniel Dardailler not be used in advertising or publicity pertaining to distribution of the software without specific, written prior permission. Daniel Dardailler makes no representations about the suitability of this software for any purpose. It is provided "as is" without express or implied warranty. Modifications Copyright 1999 Matt Koss, under the same license as above. Copyright (c) 1991 by AT&T. Permission to use, copy, modify, and distribute this software for any purpose without fee is hereby granted, provided that this entire notice is included in all copies of any software which is or includes a copy or modification of this software and in all copies of the supporting documentation for such software. THIS SOFTWARE IS BEING PROVIDED "AS IS", WITHOUT ANY EXPRESS OR IMPLIED WARRANTY. IN PARTICULAR, NEITHER THE AUTHOR NOR AT&T MAKES ANY REPRESENTATION OR WARRANTY OF ANY KIND CONCERNING THE MERCHANTABILITY OF THIS SOFTWARE OR ITS FITNESS FOR ANY PARTICULAR PURPOSE. This product includes software developed by the University of California, Berkeley and its contributors.



The following disclaimer is required by Nexidia Inc.: © 2006 Nexidia. All rights reserved. Manufactured under license from the Georgia Tech Research Corporation, U.S.A. Patent Pending.



The following disclaimer is required by Paradigm Matrix: Portions of this software licensed from Paradigm Matrix.
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The following disclaimer is required by Ray Sauers Associates, Inc.: “Install-It” is licensed from Ray Sauers Associates, Inc. End-User is prohibited from taking any action to derive a source code equivalent of “Install-It,” including by reverse assembly or reverse compilation, Ray Sauers Associates, Inc. shall in no event be liable for any damages resulting from reseller’s failure to perform reseller’s obligation; or any damages arising from use or operation of reseller’s products or the software; or any other damages, including but not limited to, incidental, direct, indirect, special or consequential Damages including lost profits, or damages resulting from loss of use or inability to use reseller’s products or the software for any reason including copyright or patent infringement, or lost data, even if Ray Sauers Associates has been advised, knew or should have known of the possibility of such damages.



The following disclaimer is required by Videomedia, Inc.: “Videomedia, Inc. makes no warranties whatsoever, either express or implied, regarding this product, including warranties with respect to its merchantability or its fitness for any particular purpose.” “This software contains V-LAN ver. 3.0 Command Protocols which communicate with V-LAN ver. 3.0 products developed by Videomedia, Inc. and V-LAN ver. 3.0 compatible products developed by third parties under license from Videomedia, Inc. Use of this software will allow “frame accurate” editing control of applicable videotape recorder decks, videodisc recorders/players and the like.”



The following disclaimer is required by Altura Software, Inc. for the use of its Mac2Win software and Sample Source Code: ©1993–1998 Altura Software, Inc.



The following disclaimer is required by Ultimatte Corporation: Certain real-time compositing capabilities are provided under a license of such technology from Ultimatte Corporation and are subject to copyright protection.



The following disclaimer is required by 3Prong.com Inc.: Certain waveform and vector monitoring capabilities are provided under a license from 3Prong.com Inc.



The following disclaimer is required by Interplay Entertainment Corp.: The “Interplay” name is used with the permission of Interplay Entertainment Corp., which bears no responsibility for Avid products. This product includes portions of the Alloy Look & Feel software from Incors GmbH. This product includes software developed by the Apache Software Foundation (http://www.apache.org/). © DevelopMentor



This product may include the JCifs library, for which the following notice applies: JCifs © Copyright 2004, The JCIFS Project, is licensed under LGPL (http://jcifs.samba.org/). See the LGPL.txt file in the Third Party Software directory on the installation CD. Avid Interplay contains components licensed from LavanTech. These components may only be used as part of and in connection with Avid Interplay.



Attn. Government User(s). Restricted Rights Legend U.S. GOVERNMENT RESTRICTED RIGHTS. This Software and its documentation are “commercial computer software” or “commercial computer software documentation.” In the event that such Software or documentation is acquired by or on behalf of a unit or agency of the U.S. Government, all rights with respect to this Software and documentation are subject to the terms of the License Agreement, pursuant to FAR §12.212(a) and/or DFARS §227.7202-1(a), as applicable.



Trademarks 888 I/O, Adrenaline, AirPlay, AirSPACE, AirSPACE HD, AirSpeed, ALEX, AniMatte, AudioSuite, AudioVision, AutoSync, Avid, Avid Advanced Response, Avid DNA, Avid DNxcel, Avid DNxHD, AVIDdrive, AVIDdrive Towers, Avid DS Assist Station, Avid ISIS, Avid Learning Excellerator, Avid Liquid, Avid Mojo, AvidNet, AvidNetwork, Avid Remote Response, AVIDstripe, Avid Unity, Avid Unity ISIS, Avid Xpress, AVoption, AVX, CamCutter, ChromaCurve, ChromaWheel, DAE, Dazzle, Deko, DekoCast, D-Fi, D-fx, DigiDelivery, Digidesign, Digidesign Audio Engine, Digidesign Intelligent Noise Reduction, DigiDrive, Digital Nonlinear Accelerator, DigiTranslator, DINR, DNxchange, do more, D-Verb, Equinox, ExpertRender, Face Robot, FACE ROBOT, FASTBREAK, Fast Track, FieldPak, Film Composer, FilmScribe, FluidMotion, FXDeko, HIIP, HyperSPACE, HyperSPACE HDCAM, IllusionFX, Image Independence, iNEWS, iNEWS ControlAir, Instinct, Interplay, Intraframe, iS9, iS18, iS23, iS36, IsoSync, LaunchPad, Lightning, Lo-Fi, Magic Mask, make manage move | media, Marquee, Matador, Maxim, MCXpress, Media Browse, Media Composer, MediaDock, MediaDock Shuttle, Media Fusion, Media Illusion, MediaLog, Media Reader, Media Recorder, MEDIArray, MediaShare, MediaStream, Meridien, MetaFuze, MetaSync, MicroTrack,
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MissionControl, NaturalMatch, Nearchive, NetReview, NewsCutter, Nitris, OMF, OMF Interchange, OMM, Open Media Framework, Open Media Management, PCTV, Pinnacle MediaSuite, Pinnacle Studio, Pinnacle Systems, ProEncode, Pro Tools, QuietDrive, Recti-Fi, RetroLoop, rS9, rS18, Sci-Fi, ScriptSync, SecureProductionEnvironment, Show Center, Softimage, Sound Designer II, SPACE, SPACEShift, SpectraGraph, SpectraMatte, SteadyGlide, Symphony, TARGA, Thunder, Thunder Station, TIMELINER, Trilligent, UnityRAID, Vari-Fi, Video RAID, Video Slave Driver, VideoSPACE, Xdeck, and X-Session are either registered trademarks or trademarks of Avid Technology, Inc. in the United States and/or other countries.
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Using This Guide Congratulations on your purchase of an Avid® VideoRAID® Serial Attached SCSI (SAS) Rackmounted (Avid VideoRAID SR) storage chassis. The Avid VideoRAID SR can be used with Avid products for both Windows® and Macintosh® operating systems. Unless otherwise noted, the material in this document applies to the Microsoft® Windows® XP, Windows Vista® and Apple® Mac OS® 10.4.11 and later.



n



When connecting the VideoRAID SR to a Macintosh workstation, the installation of a Host Bus Adapter (HBA) board is required to establish SAS connectivity. The majority of screen shots in this document were captured on a Windows system, but the information applies to both Windows and Mac OS X systems. Where differences exist, both Windows and Mac OS X screen shots are shown.



n



The documentation describes the features and hardware of all models. Therefore, your system might not contain certain features and hardware that are covered in the documentation.



Symbols and Conventions Avid documentation uses the following symbols and conventions: Symbol or Convention Meaning or Action



n



A note provides important related information, reminders, recommendations, and strong suggestions.



c



A caution means that a specific action you take could cause harm to your computer or cause you to lose data.



w >



A warning describes an action that could cause you physical harm. Follow the guidelines in this document or on the unit itself when handling electrical equipment. This symbol indicates menu commands (and subcommands) in the order you select them. For example, File > Import means to open the File menu and then select the Import command.



Symbol or Convention Meaning or Action



This symbol indicates a single-step procedure. Multiple arrows in a list indicate that you perform one of the actions listed. (Windows), (Windows only), (Macintosh), or (Macintosh only)



This text indicates that the information applies only to the specified operating system, either Windows or Macintosh OS X.



Bold font



Bold font is primarily used in task instructions to identify user interface items and keyboard sequences.



Italic font



Italic font is used to emphasize certain words and to indicate variables.



Courier Bold font



Courier Bold font identifies text that you type.



Ctrl+key or mouse action



Press and hold the first key while you press the last key or perform the mouse action. For example, Command+Option+C or Ctrl+drag.



If You Need Help If you are having trouble using your Avid product: 1. Retry the action, carefully following the instructions given for that task in this guide. It is especially important to check each step of your workflow. 2. Check the latest information that might have become available after the documentation was published: -



If the latest information for your Avid product is provided as printed release notes, they ship with your application and are also available online. If the latest information for your Avid product is provided as a ReadMe file, it is supplied on your Avid installation CD or DVD as a PDF document (README_product.pdf) and is also available online.



You should always check online for the most up-to-date release notes or ReadMe because the online version is updated whenever new information becomes available. To view these online versions, select ReadMe from the Help menu, or visit the Knowledge Base at www.avid.com/readme. 3. Check the documentation that came with your Avid application or your hardware for maintenance or hardware-related issues. 4. Visit the online Knowledge Base at www.avid.com/onlinesupport. Online services are available 24 hours per day, 7 days per week. Search this online Knowledge Base to find answers, to view error messages, to access troubleshooting tips, to download updates, and to read or join online message-board discussions. 14



Avid Training Services



Avid Training Services Avid makes lifelong learning, career advancement, and personal development easy and convenient. Avid understands that the knowledge you need to differentiate yourself is always changing, and Avid continually updates course content and offers new training delivery methods that accommodate your pressured and competitive work environment. To learn about Avid's new online learning environment, Avid Learning Excellerator™ (ALEX), visit http://learn.avid.com. For information on courses/schedules, training centers, certifications, courseware, and books, please visit www.avid.com/training or call Avid Sales at 800-949-AVID (800-949-2843).
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1 Overview The Avid VideoRAID SR is a 16-bay SAS storage enclosure featuring a high-performance SAS interface, RAID Level 5 support, and a scaling capacity from eight Terabytes (TB) to sixteen TB. The Avid VideoRAID SR includes a browser-based Graphical User Interface (GUI) configuration tool, the Avid VideoRAID SR configuration tool. The Avid VideoRAID SR is supported on both Windows and Macintosh operating systems. See the following topics: •



Features



•



Avid VideoRAID SR Front and Rear Panels



•



LCD Module



•



Avid VideoRAID SR Configuration Tool



Features All Avid VideoRAID SR enclosures include a mid plane, RAID controller, redundant power and cooling units, and an enclosure processor in one chassis design. The on-board RAID controller is hardware-based and controls all logical drive functions. The Avid VideoRAID SR supports configurations of eight or sixteen drives. Each VideoRAID SR ships with a Liquid Crystal Display (LCD) module. The LCD is an informational display unit which, provides access to information about the operating status of the VideoRAID, and alerts users to fan, power supply, and drive interruptions. Some of the key features of the Avid VideoRAID SR are: •



Easy configuration with the Avid VideoRAID SR configuration tool (browser-based)



•



Remote configuration using the browser-based configuration tool



•



Support of SATA drives



•



Scalable configurations of eight or sixteen-drives



•



Liquid Crystal Display module (LCD) for easy information access



•



Support of RAID level 5



1 Overview



The Avid VideoRAID SR offers users an expansion path for their storage needs. At this time, the following configurations are supported: Supported Configuration Configuration



Drive Size



Fully populated



500 GB



Semi-populated (8 drives)



1 TB



Fully populated



1 TB



Avid VideoRAID SR Front and Rear Panels The Avid VideoRAID SR front and rear panels are shown in the following figures. On the Avid VideoRAID SR front panel, the status LEDs indicate the operating status of the logical drive enclosure, the power, the fans, Field Replaceable Units (FRU), and the RAID controller and the RAID controller’s heartbeat.



Front Panel Upon initial power up, the disk drive LED indicator turns red. When the power up cycle completes, the LED indicators turns steady green during normal operation and blink to indicate disk drive activity. The following table outlines LED color and status. Front Panel LED Indicators Indicator



LED Color



Description



Power



Green



The power button turns steady green when the unit is powered on.



FRU



Green



The FRU turns steady green indicating normal status.



Logical Drive



Green



The logical drive turns steady green indicating normal status.



RAID Controller (01) Green



Controller Heartbeat
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During startup this LED blinks green once every five seconds, goes dark for ten seconds, and then blinks green once per second for five seconds. After startup, this LED flashes green to indicate controller activity.



Green Blinks once every two seconds to indicate normal RAID (blinking) controller operation.



Avid VideoRAID SR Front and Rear Panels



01 02



eoR Vid



aid



Power



SR



FRU status



ESC



01 02



Logical drive status RAID controller Not Used Controller heartbeat



Rear Panel The following sections show the rear panel of the Avid VideoRAID SR enclosure. The rear panel features include two power switches, two power cord connectors, an RJ-45 ethernet connector, and two serial attached SCSI (SAS) connectors (upper and lower left-side connectors). SAS data ports



Management port



MGMT



10101



Serial port



UPS



115200 8N1



Power supply 1



Cooling unit 1



Cooling unit 2



Power supply 2
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1 Overview



LCD Module Each VideoRAID SR ships with a LCD module (see the following figure). The LCD is an informational display unit which assist users in viewing the IP address of their VideoRAID SR storage chassis, information about the operating status of the VideoRAID, and alerts users to fan, power supply, and drive interruptions. Upon installation of the LCD module and startup of the Avid VideoRAID SR storage chassis, the default display on the LCD module shows the model and IP address of the storage chassis. Avid VideoRAID SR. The LCD can also display indications of any failures of drives or other enclosure components, such as the power supplies or the fans. By using the LCD button on the LCD module, you can navigate the menus to display the enclosure serial number, the raid controller firmware revision, and other enclosure information. The location of the LCD panel buttons are shown in the following figure. At this time, the LCD on the Avid VideoRAID SR storage chassis is for information purposes only.



01 02



d oRai



SR



Vide



ESC



LCD module



LCD panel buttons



For more information about using the LCD panel, see “Using the LCD Panel” on page 22.
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LCD Module



Navigating the LCD Panel Menus The LCD buttons on the LCD module determine the display content of the LCD panel. Use the LCD buttons to obtain information about the storage enclosure status. The following figures shows the LCD module and a close up of the navigation buttons which are located on the left side of the LCD module.



ESC



This figure is a close up of the navigation buttons on the LCD module.



ESC



The following table follows outlines the navigation path. LCD Panel Button Navigation Button



Description



Up



Moves up through menu items.



Down



Moves down through menu items.



Enter



Selects menu items, or enters sub-menus.



Escape (ESC)



Exits sub-menus, or returns to the Idle Mode screen.



For more information about using the LCD panel control buttons, see “Navigating the LCD Panel Menus” on page 21.
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1 Overview



Using the LCD Panel The Avid VideoRAID SR LCD panel displays system information and provides access to many of the product’s features and functions. The LCD screen activates approximately 35 seconds after the enclosure is powered on and begins the initialization process. During this time the LCD panel displays the message System is Initializing. Once the initialization process is complete, the LCD panel enters Idle Mode and displays the enclosure’s model number and IP address. If a condition is present that requires your attention, the LCD panel displays the enclosure’s IP address and status message. When the network cable is not plugged into the Management port on the back of the VideoRAID SR, the LCD panel displays “NO NETWORK.”



Disk Drive LEDs Upon initial power up, the disk drive LED indicator turns red. When the power up cycle completes, the LED indicators turns steady green during normal operation and blink to indicate disk drive activity. The disk drive LEDs provide information about the status of the system’s disk drives. The following illustration shows the location of the drive LEDs and the following table outlines their color and status:



Disk status Power / Activity



Disk Drive LED Indicators LED Indicator



Description



Power/Activity



Lights steady green indicating power. Lights blinking green indicating activity.



Disk status
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Lights steady green to indicate a drive is present and configured.



Avid VideoRAID SR Configuration Tool



RAID The Avid VideoRAID SR supports RAID level 5 ensuring that if a drive fails, the VideoRAID SR can automatically begin the rebuild process once a new drive is installed in the enclosure without disruption to the storage process.



Shipping Kit Visually inspect the shipping carton for damage. If there is any damage, do not remove the contents and notify your Avid representative. Check the packing list to verify you have received all the items. Each Avid VideoRAID SR enclosure kit contains:



n



n



•



VideoRAID SR storage enclosure



•



Liquid Crystal Display module



•



Disk drives (eight or sixteen) boxed separately within enclosure packaging)



•



Drive Filler Panels (if necessary)



•



Power cord: 1.5 m (4.9 ft), (2)



•



Serial Attached SCSI (miniSAS) cable: 3m (9.8 ft)



Cable lengths of 1 m (3.28 ft) and 5 m (16.4 ft) are available. If you are using any other cable length than the three meter cable, you must set the cable length signal strength before using your Avid VideoRAID SR storage enclosure. See “Setting Cable Signal Strength” on page 53. •



Serial DB-9 to RJ-11 cable



•



Avid VideoRAID ST/SR Installation CD



•



ATTO H380 SAS Host Bus Adapter (HBA) board (Macintosh)



Use Cat 5e (minimum) or Cat 6 (preferred) network cables with Avid VideoRAID SR. •



Mounting rails (left and right) and center-mount brackets



Avid VideoRAID SR Configuration Tool The Avid Configuration Tool is a browser-based Graphical User Interface (GUI) which allows users to monitor and configure the VideoRAID SR. In addition, an LCD module is included which provides you with information about your VideoRAID SR such as the storage enclosure’s IP address which assists you in accessing the configuration tool.
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1 Overview



In order to log into the Avid Configuration Tool, you must first setup a network connection between your host computer and the Avid VideoRAID SR enclosure. The Avid VideoRAID SR ships with DHCP enabled by default. Upon initial startup, the LCD module displays the IP address and model of your Avid VideoRAID SR storage enclosure. You use this IP address to access the Avid configuration tool through your web browser. The following figure represents the opening web browser window of the Avid VideoRAID SR configuration tool. See “Accessing the Avid VideoRAID SR Configuration Tool” on page 55 for more information on the configuration tool.
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2 Installing the Avid VideoRAID SR The installation process for the Avid VideoRAID SR requires preparing for the installation, unpacking the Avid VideoRAID SR, attaching the LCD module, and rack-mounting the enclosure. The next steps in the process are cabling and connecting the unit and installing the drives. See the following topics: •



Preparing for Installation



•



System Requirements



•



Attaching the LCD Panel



•



Rack-mounting the Avid VideoRAID SR



•



Installing Disk Drives



•



Connecting and Cabling the VideoRAID SR



•



Updating Firmware (BIOS) and LSI Drivers (HP xw8400)



•



Connecting the VideoRAID SR to the Macintosh



•



Using the Disk Management Utility



Preparing for Installation Preparing for installation includes ensuring that the area where you install the Avid VideoRAID SR meets the electrical and environmental requirements. Use the following environmental and electrical requirements in planning for your installation.



n



If you are installing the VideoRAID SR on a Macintosh or are installing the VideoRAID SR on an HP xw8400 workstation, see “System Requirements” on page 26.



Environmental Requirements The site you choose for your Avid VideoRAID SR should meet the following environmental conditions: •



Clean and dust free.



•



Free from significant temperature or humidity changes.



2 Installing the Avid VideoRAID SR



•



Rack mount that is sturdy, level, and not subject to vibration.



•



Away from radio frequency emissions, high-traffic, or high-noise areas.



•



Adequate space in front of and behind the components, so you can connect cables and service your Avid VideoRAID SR. This also provides adequate airflow for cooling.



Electrical Requirements Select your site with the following electrical requirements in mind: •



Make sure there are adequate power outlets for the Avid VideoRAID SR. This prevents the need for extension cords.



•



Make sure your site is away from major electrical equipment such as motors, air conditioners, or elevators.



•



Make sure the location is not subject to static electrical buildup.



•



Plug only the VideoRAID SR and other system equipment into the power strip. Do not plug in coffee makers, radios, lights, or other non-Avid devices. Avid recommends the use of an uninterruptible power supply (UPS) appropriately sized for your system configuration. The UPS provides system protection against sudden power surges or losses that could cause you to lose your work.



System Requirements The Windows and Macintosh workstations currently supported with the Avid VideoRAID SR as well as third-party boards are listed on the Avid web site. As more systems and third-party boards are tested and qualified, and as different configurations meet approval, they will be posted on the Avid web site. For the latest information concerning workstations qualified with the Avid VideoRAID SR, go to www.Avid.com.



n



All Windows workstations must have an on-board SAS connector to connect to the Avid VideoRAID SR. For additional information, see the Avid web site for system specifications. In addition to the above system requirements for workstations supported with the Avid VideoRAID SR, if you are connecting the VideoRAID SR to either a Hewlett-Packard® xw8400 workstation or a Macintosh workstation, specific procedures must be completed before using any disk utility program. See the following sections “Windows Workstations” on page 27 or “Macintosh Workstations” on page 27.
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Attaching the LCD Panel



Windows Workstations When connecting the VideoRAID SR to an Hewlett-Packard® xw8400 workstation, it is necessary to update the BIOS and firmware on the embedded LSI SAS controller using a bootable USB removable drive and to install LSI drivers for the embedded LSI SAS controller. These procedures must be performed for all HP xw8400 workstations. Complete the BIOS and firmware update and then the LSI driver installation after connecting and turning on your VideoRAID SR but before you perform any disk utility operation. See “Updating Firmware (BIOS) and LSI Drivers (HP xw8400)” on page 35.



Macintosh Workstations Select the Macintosh operating system on the VideoRAID SR, see “Selecting the Operating System” on page 52. This procedure must be performed for all Macintosh workstations. Selecting the operating system is completed after connecting and turning on your VideoRAID SR but before you perform any disk utility operation.



Installing the Host Bus Adapter (Macintosh) The ATTO H380 HBA controller board needs to be installed in Macintosh workstations to provide SAS connectivity. The H380 controller board ships with the Avid VideoRAID SR and must be installed in a PCI Express (PCIe®) mechanical slot. See the manufacturer’s documentation that came with your workstation for instructions on installing additional board sets and for the location of your PCIe slots.



c



Anti-static precautions must be used when handling hardware components and boards. Never touch any exposed electrical connectors on the components as they can be damaged by electrostatic discharge (ESD). The Macintosh workstations currently supported with the Avid VideoRAID SR are listed on the Avid web site. As more workstations are tested and qualified, and as different configurations meet approval, these configurations will be posted on the Avid web site. For the latest information concerning workstations qualified with the Avid VideoRAID SR, go to www.Avid.com.



Attaching the LCD Panel The Avid VideoRAID SR LCD panel ships in a separate box inside the Avid VideoRAID SR shipping box. The LCD panel connects to the Avid VideoRAID SR through a 10-pin connector located in the left bracket of the enclosure. The LCD panel ships separately to ensure protection of the 10-pin connector. Use the following procedure to attach the LCD module to the Avid VideoRAID SR storage chassis. 27



2 Installing the Avid VideoRAID SR



Use the following procedure to attach the LCD module to the Avid VideoRAID SR storage chassis.



c



Use of an anti-static precautions when handling hardware components and boards. Never touch any exposed electrical connectors on the components as they can be damaged by electrostatic discharge (ESD). To attach the LCD panel:



1. Be sure you are using some type of antistatic protection before beginning this procedure. 2. Remove the left handle mount from the enclosure by removing the two mounting screws.
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3. Remove the LCD module from the packing box.
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Attaching the LCD Panel



4. Carefully align the 10-pin connector on the back of the LCD panel with the 10-pin connector on the enclosure.
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5. Attach the LCD panel to the enclosure using the same screws you removed in step 1.
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2 Installing the Avid VideoRAID SR



Rack-mounting the Avid VideoRAID SR The Avid VideoRAID SR enclosure attaches to the rack using the supplied mounting rails. You can also use your existing rails. The Avid VideoRAID SR is designed for 19-inch (483-mm) rack enclosures and requires three EIA rack units (3 RU), or 5.25 inches (133.3 mm) of rack space. The VideoRAID SR ships with rack-nut clips for rack enclosures that do not have threaded holes. Threaded rack-nut clips slide into the holes of the rack and provide the threaded holes to secure the rack components. VideoRaid SR



When installing the Avid VideoRAID SR into a rack, observe the following precautions: •



To ensure the stability of the rack enclosure, start from the bottom when you install the rack components in the rack enclosure.



•



Install the Avid VideoRAID SR into a rack without the drives installed, to avoid injury and damage to the unit.



•



At least two persons are required to safely lift, place, and attach the Avid VideoRAID SR enclosure into a rack system.



•



Do not lift or move the Avid VideoRAID SR enclosure by the handles, power supplies or the controller units. Hold the enclosure itself.



•



Do not install the Avid VideoRAID SR enclosure into a rack without rails to support the enclosure.



•



Be sure all switches are OFF before installing the Avid VideoRAID SR enclosure or exchanging components.



To install the Avid VideoRAID SR enclosure into a rack:



1. Check the fit of the mounting rails in your rack system. 2. Adjust the length of the mounting rails as needed. 3. Attach the mounting rail assemblies to the outside of the rack posts, using the attaching screws from your rack system. 30



Installing Disk Drives



4. Be sure the support is on the bottom facing inward. 5. Square the rail assemblies in the rack. 6. Tighten the adjustment screws and the attaching screws. 7. Place the Avid VideoRAID SR enclosure onto the rails. 8. Secure the Avid VideoRAID SR enclosure to the rack through each handle, using the attaching screws from your rack system Rack mount assembly diagram Rack back post



Rack front post Rail attaching screw (not included)



Rail attaching screw (not included) Front rail



Rear rail



Flange



Support



Rail adjustment screw Inside of post



Rail adjustment screw



Inside of post



Installing Disk Drives The disk drives (set of eight or sixteen) ship separately from the Avid VideoRAID SR enclosure. The Avid VideoRAID SR storage enclosure must be fully populated at all times. This means that if you are installing eight drives into VideoRAID SR, you will need to install eight drive filler modules. The drive slots on the Avid VideoRAID SR are numbered one through sixteen. Drives and drive filler modules must be installed following the number sequence one through sixteen. For example, if you are installing eight drive modules, slots numbered one through eight must be populated first and then slots numbered nine through sixteen are populated next. If you are installing sixteen drive modules, populate the slots numbered one through eight first and then populate the slot numbered nine through sixteen next.
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2 Installing the Avid VideoRAID SR



c



Install disk drives and drive filler modules before you connect the Avid VideoRAID SR to the host computer. Avid VideoRAID SR Drive Slot Configuration VideoRaid SR



1



2



3



4



5



6



7



8



9



10



11



12



13



14



15



16



Slots 1–8 Populated Drive Modules Slots 9–16 Drive Filler Modules



To install the drive modules and drive filler modules into the Avid VideoRAID SR enclosure:



1. Ensure that the Avid VideoRAID SR is turned off. 2. Ensure that you are using the appropriate anti-static precautions.



n



Anti-static precautions, for example, the use of an anti-static mat or anti-static wrist or ankle straps, must be used when handling hardware components and boards. Never touch any exposed electrical connectors on the components as they can be damaged by electrostatic discharge (ESD) 3. Remove the disk drive from the anti-static shipping bag. 4. Open the drive by opening the disk drive release latch.



n



Always populate the drive slots in the correct numerical order, beginning with slot number one and ending with slot sixteen. During normal operation,



VideoRaid SR
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Installing Disk Drives



5. Insert the disk drive into slot number one of the Avid VideoRAID SR enclosure.



Avid VideoRAID SR Drive Slot Configuration VideoRaid SR
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Slots 1–8 Populated Drive Modules Slots 9–16 Drive Filler Modules



The drives snaps into place. 6. Press the disk drive release latch closed to secure the drive in the enclosure. 7. Following the numerical order, insert the next disk drive into slot 2, then slot 3, etc. Repeat Steps 3 through Step 6 for each remaining disk drive or drive filler modules until all drive slots are populated.



c



During normal operation, never remove a fully functional disk drive while the VideoRAID SR is operational.



Upgrading the VideoRAID SR If you perform an initial installation of eight disk drives and want to upgrade your VideoRAID SR to sixteen drives, there are two upgrade paths. One upgrade procedure is to install the new eight drives in bay slots numbered 9 through 16 and configure these new eight drives as a separate volume from your existing eight-drive configuration. The other alternative is to install the additional eight drives in bay slots numbered 9 through 16 and configure these new eight drives with the existing eight drives as a single volume. If you choose the first upgrade procedure, you follow the instructions as outlined in this chapter for the disk drive installation process and configuration of a separate volume. If you choose the second method, you must backup all your existing data to a separate location as the reconfiguration of the VideoRAID SR from an eight-bay storage unit to a sixteen-bay storage unit involves the importation of a script which will delete all the existing media on the drives. This procedure should be done only with the assistance of an Avid Customer Service representative.



c



Importing the configuration file deletes all existing data on the Avid VideoRAID SR. This procedure should be performed only with the assistance of an Avid Customer Support Representative.
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2 Installing the Avid VideoRAID SR



Connecting and Cabling the VideoRAID SR You are now ready to cable and connect your Avid VideoRAID SR. Each Avid VideoRAID SR ships with two power cords and a mini-SAS cable. The mini-SAS cable length is three (3) meters (4.8 feet).



n



If you are using a cable length other than the default length of three meters, you must configure the signal strength for the specific cable length you are using. See “Setting Cable Signal Strength” on page 53. To connect your Avid VideoRAID SR:



1. Turn off your workstation before connecting the Avid VideoRAID SR.



n



If you installed the HBA controller board into your Macintosh workstation, ensure that the side cover on your workstation has been reinstalled before beginning this connection process. 2. Plug one end of the mini-SAS cable into the bottom left mini-SAS connector on the rear of the Avid VideoRAID SR, as shown in the following illustration.



n



Do not use the top SAS connector on the Avid VideoRAID SR enclosure. 3. Plug the other end of the mini-SAS cable into the mini-SAS port on your workstation (Windows) or in the HBA mini-SAS port (Macintosh) on your workstation. SAS data port



Management port



Serial port



115200 8N1



4. For each power connection, plug one end of the power cord into the power connector on the Avid VideoRAID SR and the other end into a properly grounded power outlet. 5. Connect the Ethernet cable into the Ethernet port on the rear of the Avid VideoRAID SR. 6. Connect the other end of the Ethernet cable into the Ethernet port on your network switch. 7. Turn on the Avid VideoRAID SR.
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Updating Firmware (BIOS) and LSI Drivers (HP xw8400)



n



If during normal operations a disk drive appears to be defective or non-operational, you must save your data and turn off your Avid VideoRAID SR before removing any defective drives or before beginning to rebuild your array. When boot-up is finished and the Avid VideoRAID SR is functioning normally: -



The Controller LED blinks green once per second for five seconds, goes dark for ten seconds, then blinks green once per second for five seconds again.



-



The Power, FRU and Logical Drive LEDs display green continuously.



-



The Controller LEDs flash green if there is activity on that controller.



8. Once the Avid VideoRAID SR boots successfully, you can start the host computer.



n



During the power on process when the host computer scans the volume of the disk drive, the computer monitor may temporarily go black and the LEDs on the Avid VideoRAID SR may flash. This is a normal part of the power on process.



Updating Firmware (BIOS) and LSI Drivers (HP xw8400) On all HP xw8400 workstations, it is necessary to update the BIOS and firmware on the embedded LSI SAS controller. The BIOS and firmware upgrade process involves creating a Universal Serial Bus (USB) bootable removable drive which is then used to reboot and update the firmware on your workstation. The BIOS and firmware update at the same time. After the BIOS and firmware update, the next step is to install the LSI driver for the embedded LSI SAS controller. The files required for this BIOS and firmware and LSI driver update are located on the Avid VideoRAID ST/SR CD that ships with the VideoRAID SR. Download these files to your workstation before beginning these two procedures.



c



Before performing any of these procedures, see the documentation that shipped with your workstation to ensure that the BIOS boot sequence is set to accept the default boot location where you USB removable drive will be installed. You may need to manually configure your workstation.



Creating a Bootable USB Removable Drive The steps to create a bootable USB removable are outlined in the following procedure. After you create the USB removable drive, you then use this bootable USB removable drive to boot your workstation. Before you being this procedure, you need to backup any data that may be on your USB removable drive as this procedure will overwrite the existing data on the USB removable drive. 35



2 Installing the Avid VideoRAID SR



c



Before performing any of these procedures, if you are moving your VideoRAID SR from a Macintosh workstation to a Windows workstation, you must back up your data on to a different location before beginning this procedure. To create a bootable USB removable drive and update your firmware:



1. Extract the firmware update package from the Avid VideoRAID ST/SR Installation CD to a known location on your workstation. 2. Click on Start > Run. The Run dialog box displays. 3. Type the command CMD and click OK. The command prompt window opens. 4. Change to the directory to the location where you extracted the firmware update package to. 5. Insert your USB removable drive into your workstation and note what drive letter windows assigns the removable drive.



n



Make sure you have moved any data on your USB removable drive that you wish to save to a safe location. This procedure overwrites any existing data on the USB removable drive. 6. In the command prompt window, type MKUSB . Right click on the newly partitioned drive and choose Format from the drop-down list.



c



This step will overwrite any existing data on the specified drive letter. 7. Close the command window when the procedure completes. 8. Use the “Safely Remove Hardware” icon in the system tray before removing the USB removable drive. 9. Shut down your workstation. 10. Insert the USB removable drive into the workstation and reboot your workstation. 11. At the DOS prompt, type fla_sas.bat. The formatting of your disk begins. 12. Shut down your workstation when the reformatting is complete. 13. Restart your workstation. The HP xw8400 workstation reboots and automatically updates the firmware to the required version.
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Updating Firmware (BIOS) and LSI Drivers (HP xw8400)



Installing and Updating the LSI Drivers The LSI drivers for the embedded LSI SAS controllers are located on the Avid VideoRAID ST/SR Installation CD. After the firmware update, use the following steps to install the LSI drivers. To install and update the LSI Drivers for the embedded LSI SAS controller:



1. Extract the LSI driver for the operating system you are using (XP or Vista) from the Avid VideoRAID ST/SR CD to a known location on your workstation. 2. Click on Start > My Computer. Right click and select Manage. The Computer Management dialog box opens. 3. Select Device Manager. The computer management window opens.



4. Select “SCSI and RAID controllers” from the right-hand pane of the computer management window.
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2 Installing the Avid VideoRAID SR



5. Right-click the “LSI Adapter, SAS 3000 series, 4-port with 1064” choice in the right-hand pane (under SCSI and RAID controllers) and choose Update Driver from the menu selection.



The Driver Installation Wizard opens. 6. Click through the Driver Installation Wizard, selecting the new LSI driver from the location where you download and extracted its contents on your workstation. 7. Click through the wizard and click Finish. 8. Reboot the workstation. The installation of the LSI driver for the embedded LSI SAS controller is complete.



Connecting the VideoRAID SR to the Macintosh To prepare your Macintosh workstation for the VideoRAID SR, make sure you have set the VideoRAID SR to run on your Macintosh operating system, see “Selecting the Operating System” on page 52. The Macintosh workstation also requires that you install the H380 Host Bus Adapter (HBA) controller board, upgrade the Macintosh OS to 10.5.3 or later, and installing the H380 HBA controller board driver. Installation procedures are different for Macintosh Early 2008 (Harpertown) and Mac Pro (non-Harpertown) workstations. Please choose the appropriate procedure for your particular Macintosh workstation. If you need to o verify your workstation’s type, see “Identifying the Macintosh Early 2008 (Harpertown) Workstation” on page 39. 38



Connecting the VideoRAID SR to the Macintosh



n



Each workstation has a unique slot configuration. Slot configurations for all supported workstations are listed and updated on the Avid Knowledge Base. For the most up-to-date information on slot configurations, go to www.avid.com. The ATTO™ H380 Host Bus Adapter (HBA) controller board needs to be installed in Macintosh workstations to provide SAS connectivity. The H380 controller board ships with the Avid VideoRAID SR and must be installed in a PCI Express (PCIe®) mechanical slot. See the manufacturer’s documentation that came with your workstation for instructions on installing additional board sets and for the location of your workstation’s PCIe slots.



n



Always visit the Avid web site to ensure you are using the most up-to-date slot configuration information for your workstation.



Identifying the Macintosh Early 2008 (Harpertown) Workstation If you need to identify whether your workstation is a Mac Early (2008) or a Mac Pro (non-Harpertown), use the following procedure. To identify your Macintosh Workstation model:



1. Select Apple > About This Mac. The About This Mac dialog box opens.
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2 Installing the Avid VideoRAID SR



2. Click the More Info button. The Administrator’s Mac Pro dialog box opens. If you have an Early 2008 (Harpertown) Macintosh, the following Mac Pro dialog box opens.



The Model Identifier of MacPro 3, 1 identifies this particular workstation as an Early 2008 (Harpertown). If the Model Identifier is a MacPro 1,1 or MacPro 1,2, the Macintosh is a Mac Pro (non-Harpertown) workstation.



Installing and Connecting the Early 2008 (Harpertown) Workstation



n



If you are an Avid Unity MediaNetwork client, you must remove the ATTO FC 41-EL card and replace it with the ATTO FC-ES card. To prepare your Early 2008 (Harpertown) Macintosh workstation:



1. Select the Macintosh operating system on the VideoRAID SR, see “Selecting the Operating System” on page 52. 2. Turn off your workstation and ensure you are following anti-static precautions before installing the HBA controller board.



c 40



Use anti-static precautions handling hardware components and boards. Never touch any exposed electrical connectors on the components as they can be damaged by electrostatic discharge (ESD).



Connecting the VideoRAID SR to the Macintosh



3. Install the HBA controller card in the slot specified in the most up-to-date slot configuration guide listed on the Avid web site.



n



Go to www.avid.com and search the knowledge base for “slot configurations” to ensure the slot configurations you are using are the most up-to-date. 4. If you are using Avid Unity MediaNetwork on your Mac workstation, remove the ATTO FC 41-EL card and replace it with the ATTO FC-ES card. See the slot configuration guide listed on the Avid web site to ensure the slot configurations you are using are the most up-to-date. 5. Turn on your workstation. 6. Upgrade your workstation to the Mac OS 10.5.3 or later. Restart your workstation when you are prompted during the upgrade process. 7. Download and install the v111 driver for the HBA controller card from the Avid Download Center and restart your workstation when prompted during the installation process.



Installing and Connecting the Mac Pro (Non-Harpertown) Workstation To prepare your Mac Pro (non-Harpertown) Macintosh workstation:



1. Select the Macintosh operating system on the VideoRAID SR, see “Selecting the Operating System” on page 52. 2. Turn off your workstation and ensure you are following anti-static precautions before installing the HBA controller board.



c



Use anti-static precautions handling hardware components and boards. Never touch any exposed electrical connectors on the components as they can be damaged by electrostatic discharge (ESD). 3. Install the HBA controller card in the slot specified in the most up-to-date slot configuration guide listed on the Avid web site. 4. Go to and search the knowledge base for “slot configurations” to ensure the slot configurations you are using are the most up-to-date. 5. Turn on your workstation. 6. Upgrade your workstation to the Mac OS 10.5.3 or later. Restart your workstation when you are prompted during the upgrade process. 7. Download and install the v111 driver for the HBA controller card from the Avid Download Center,. Restart your workstation when prompted during the installation process.
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2 Installing the Avid VideoRAID SR



Using the Disk Management Utility The Disk Management Utility on your workstation is the utility used to create partitions on the disk drives of the Avid VideoRAID SR. It is recommended to always use the quick initialization during initialization, as it allows users to create their partitions while the RAID configuration process is active.



n



Always partition as a single volume. There is no stripping required.



Windows XP To create partitions on your RAID configuration:



1. Click on the Start > My Computer and right-click to open the drop down menu. The computer management window displays:



42



Using the Disk Management Utility



2. Right-click and select Manage. The Computer Management Window opens.
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2 Installing the Avid VideoRAID SR



3. Right-click the newly installed, unallocated disk drive.



n



For all Vista and Windows 64-bit systems, always choose GPT. This is imperative. To choose GPT, right-click the unallocated disk drive and select Convert to GPT disk. After choosing the GPT disk option, proceed with disk management.



4. Click New > Simple Volume. The Initialization Wizard displays. 5. Click Next through the Wizard to create the new volume. Disk management partitions your Avid VideoRAID SR as one partition.
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Using the Disk Management Utility



6. Right click on the newly partitioned drive select Format. The Format dialog box displays.



7. Choose NTFS for File system > NTFS and select Perform a quick format. 8. Click Ok. The formatting of your disk begins. Upon completion, your Avid VideoRAID SR is ready to use.



Windows Vista To create partitions on your RAID configuration:



1. Click Start > Computer, right-click and select Manage. 2. Select Storage > Disk Management. The Disk Management Window opens.



45



2 Installing the Avid VideoRAID SR



3. Right click your Avid VideoRAID SR, and choose New Simple Volume.



c



You must always select GPT on all Windows Vista and Windows 64-bit systems. To select GPT, right-click the unallocated disk drive and select Convert to GPT disk. After selecting the GPT disk option, proceed with disk management.
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Using the Disk Management Utility



4. Click OK. The Initialization Wizard displays. Click Next through the Wizard to partition your disk. Disk management partitions your Avid VideoRAID SR as one partition. 5. Right click on the newly partitioned drive and choose Format from the drop-down list. The Format dialog box displays.



6. Select File system > NTFS and select Quick format. 7. Click OK. The formatting of your disk begins. Upon completion, your Avid VideoRAID SR is ready to use.



Macintosh The ATTO ExpressStripe utility is used to format, partition, and stripe your drives on a Macintosh operating system.
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2 Installing the Avid VideoRAID SR



To launch ExpressStripe:



1. Follow the folder structure on the Avid VideoRAID ST/SR installation CD to the Avid VideoRAID ST folder, and locate the ExpressStripe application. Double-click the installer file. 2. Click Create. The ExpressStripe tool opens.



3. Click Delete and then click Volume to delete the volume.



48



Using the Disk Management Utility



4. Click Create and in the next window, click Initialize.



5. Select the drives you want to initialize and click Next.
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2 Installing the Avid VideoRAID SR



6. Click the Drives verified button and then click OK.



n



Make sure you are choosing the newly installed disk drive (unallocated drive) to partition. 7. Click Continue. 8. Click Create a Standard Volume and click Next. 9. Click continue. 10. Choose how many volumes you want and click Next.
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Using the Disk Management Utility



11. Select Format > Mac OS Extended (Journaled).



12. Click Finish.



13. Click Quit. Your Avid VideoRAID ST is ready to use.
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2 Installing the Avid VideoRAID SR



Selecting the Operating System The VideoRAID SR is shipped configured for a Windows operating system. If you are connecting the VideoRAID SR to a Windows operating system you do not need to perform the following procedure. This procedure is required if connecting the VideoRAID SR to a Macintosh system. Also use this procedure if you are moving your VideoRAID SR back and forth between the two operating systems. To set the SAS port for Windows or Macintosh:



1. Open the VideoRAID SR configuration tool in your browser. 2. Click on the Administrative Tools > SAS Management in the left-handed side of the web browser. 3. Click the Global Settings tab.



4. Depending on your operating system, select or deselect the “Enable Narrow Port.” t



Windows — deselect Enable Narrow Port (as shown)



t



Macintosh — select Enable Narrow Port



5. Click Submit.
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Setting Cable Signal Strength If you are installing your VideoRAID SR with any other cable length other than the default length of three meters, you need to set the cable signal strength on the cable. The Avid VideoRAID SR configuration tool provides the access to the VideoRAID SR cable strength settings. To set the signal strength for your cable length:



1. Open the VideoRAID SR configuration tool in your browser. 2. Click on the Administrative Tools > SAS Management in the left-handed side of the web browser.
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2 Installing the Avid VideoRAID SR



3. Click on Port 1.



4. Select the cable length from the Cable Signal Strength menu in the right-hand pane of the web browser. 5. Click Submit.
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3 Configuring the Avid VideoRAID SR Once your Avid VideoRAID SR storage enclosure is connected and turned on, you are ready to use your VideoRAID SR. The VideoRAID SR configuration tool provides information about the operational status of your VideoRAID SR drives and components as well as allowing the configuration of event notifications. The Avid VideoRAID SR configuration tool’s flexibility allows users to define the tool’s capabilities for their particular storage environment. For information about Avid VideoRAID SR’s audible alarm and LEDs, see “Troubleshooting” on page 107.



Accessing the Avid VideoRAID SR Configuration Tool The Avid VideoRAID SR configuration tool is a browser-based User Interface (UI). You access the VideoRAID SR through your web browser UI by inputting the IP address of your Avid VideoRAID SR into your web browser location bar. The Avid VideoRAID SR ships with Dynamic Host Configuration Protocol (DHCP) enabled. In a network environment which supports DHCP, when a VideoRAID SR is connected to a host workstation and turned on, DHCP automatically assigns the VideoRAID SR storage enclosure an IP address and displays this IP address in the LCD module on the front of the VideoRAID SR. By entering this IP address in a web browser location bar, users directly connect to the Avid VideoRAID SR configuration tool. If your facility does not support DHCP or if your VideoRAID SR is not installed on a network, you can establish a serial connection to the VideoRAID SR using a serial cable (which ships with the VideoRAID SR) and a Telnet emulation tool. Establishing a serial connection enables you to alter the configuration of the VideoRAID SR by disabling DHCP and assigning an IP address to your workstation. You then use this IP address to access the Avid VideoRAID SR configuration tool. For instructions on configuring the VideoRAID SR through the serial port, see “Serial Connection to the VideoRAID SR Configuration Tool” on page 62.



3 Configuring the Avid VideoRAID SR



If you select to keep DHCP enabled, have your Network Administrator dedicate an IP address for the Avid VideoRAID SR, linked to the Avid VideoRAID SR’s MAC address. This action prevents the DHCP server from assigning a new IP address when the Avid VideoRAID SR restarts, with the result that users can no longer log in. To log into the Avid Configuration Tool:



1. Start your web browser. 2. In the browser address field, type in the IP address of the Avid VideoRAID SR Management port. This IP address displays in the LCD module.



n



The IP address shown used in this section is an example. The IP address you type into your browser might be different. t



Regular Connection The Avid Configuration Tool uses an HTTP connection (http://). Enter the Avid VideoRAID SR’s Management Port IP address 192.168.10.85



Together, your entry looks like this: http://192.168.10.85



t



Secure Connection The Avid Configuration Tool uses a secure HTTP connection (https://). Enter the Avid VideoRAID SR’s Management Port IP address 192.168.10.85



Together, your entry looks like this: https://192.168.10.85



n



Whether you select a regular or a secure connection, your login to the Avid Configuration Tool and your user password are always secure. 3. When the log-in screen appears:
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a.



Type administrator in the User Name field.



b.



Type password in the Password field.



Accessing the Avid VideoRAID SR Configuration Tool



c.



Click the Login button.



The Avid VideoRAID SR configuration tool opens.



The User Name and Password are case sensitive.



Once you have logged into the configuration tool, you can set up users and assign passwords inside the configuration tool. See “Managing Users” on page 79.



Selecting a Language The Avid Configuration Tool displays in English, German, French, Italian, Spanish, Russian, Japanese, Chinese Traditional, Chinese Simple, and Korean. 57



3 Configuring the Avid VideoRAID SR



To select a language:



1. Click Language the Avid Configuration Tool Header. The language list appears in the Header. 2. Click the language you prefer. The the Avid Configuration Tool user interface displays in the selected language.



Using the Avid VideoRAID SR Configuration Tool The Avid Configuration Tool is browser-based RAID management software with a graphical user interface.
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Using the Avid VideoRAID SR Configuration Tool



There are four major parts to the graphic user interface: •



Header — the top menu bar (see “Using the Header” on page 59)



•



Tree — the left-handed pane of the browser (see “Using Tree View” on page 60)



•



Management View — the upper right-handed pane of the browser pane (see “Using Management View” on page 60)



•



Event Frame - lower right-handed pane of the browser pane (see “Viewing the Event Frame” on page 61)



Using the Header The Header contains the following items: •



Language – To change languages, see “Selecting a Language” on page 57.



•



View – To view the Event Frame, see “Viewing the Event Frame” on page 61.



•



Storage Network – To view all of the Avid VideoRAID SR enclosure enclosures currently accessible the network, see “Working with the Storage Network” on page 71.



•



Logout – To logout of the Avid Configuration Tool, see “Logging out of the Avid Configuration Tool” on page 62



•



Help – Click Help in the Header to access the main online help menu.



•



About – Click About in the Header to display the Avid Configuration Tool software version and build date.
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Using Tree View Tree View enables you to navigate around all components of the Enclosure, including Serial Attached SCSI management, network and service management, RAID controller, enclosure, physical drives, disk arrays, and logical drives. The following illustration shows the components of Tree View. Name of logged-in user



IP address and model



SAS Management



Physical Drives



The Administrative Tools section is different for the Super User than for other users. The remainder of the Tree is the same for all users. Management View displays information according to the item you select in Tree View.



Using Management View Management View provides the actual user interface with the Avid VideoRAID SR, including creation, maintenance, deletion, and monitoring of disk arrays and logical drives. Function Tabs control specific actions and processes. This window changes depending on which item you select in Tree View and which tab you select in Management View itself. Click the Help button in Management View to access online help for the function that is currently displayed. 60
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Viewing the Event Frame To view the Event Frame:



1. Click View in the Header. 2. Click the Show Event Frame popup option. The Avid VideoRAID SR user interface displays the Event Frame below Management View. The following table lists the columns in the Event Frame and their descriptions: Column



Description



Item Number



A consecutive decimal number assigned to a specific event.



Device



Controller, logical drive, physical drive, port, etc.



Event ID



The hexadecimal number that identifies the specific type of event.



Severity



Information, Warning, Minor, Major, Critical, and Fatal. The severity level is user-specified. See “Setting Up User Event Subscriptions” on page 80.



Time



Time and date of the occurrence



Description



A brief description of the event.



To hide the Event Frame:



1. Click View in the Header. 2. Click the Hide Event Frame popup option. The Avid VideoRAID SR user interface hides the Event Frame.



Sorting Events You can sort the events by Item Number, Device, Event ID, Severity, Time and Date, or Description. Click the link at the top of the column by which you want to sort the events. After you click the item, a triangle icon appears. •



If the triangle points upward, the column is sorted low-to-high or old-to-new.



•



If the triangle points downward, the column is sorted high-to-low or new-to-old.



Click the link a second time to change to flip the triangle and reverse the sort sequence.
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Logging out of the Avid Configuration Tool To log out of the Avid Configuration Tool, do one of the following:



t



Close your browser window



t



Click Logout the Avid Configuration Tool banner



Clicking Logout brings you back to the Login Screen. After logging out, you must enter your user name and password in order to log in again.



Serial Connection to the VideoRAID SR Configuration Tool This procedure shows you how to establish a serial connection from your workstation to your VideoRAID SR. Before beginning this procedure, ensure that you have the serial cable (DB9-pin to RJ-11) and a Telnet emulation tool installed for your particular system. The serial cable ships with the VideoRAID SR enclosure. Some workstations ship with Windows® HyperTerminal or you may choose a Telnet emulation tool for your particular operating system. The following procedure uses screen shots captured on a Windows® XP Operating System (OS). If you are using a different operating system, your screen shots might differ. Follow the procedure for connecting and cabling the VideoRAID SR outlined in the Avid VideoRAID SR Setup and User’s Guide. Then use the procedure for establishing a serial connection.



n



Most operating systems ship with a Telnet emulation tool. If your workstation does not have a resident Telnet emulation tool, refer to the manufacturer’s documentation that came with your workstation.



Serial Connection The procedure describes the serial cabling between your workstation VideoRAID SR. To establish a serial connection from your workstation to the Avid VideoRAID SR:



1. Turn on your workstation and the VideoRAID SR.
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When the VideoRAID SR is completely started, the display on the VideoRAID SR’s LCD module reads “NO NETWORK” (when no network cable is plugged-in).



Serial Connection to the VideoRAID SR Configuration Tool



2. Connect the DB-9 pin connector end of the serial cable to the DB-9 connection port on your workstation.



DB-9 pin serial connector



S A S



3. Connect the other end of the serial cable (RJ-11) to the serial port on the rear of the VideoRAID SR. Serial port



MGMT



10101



UPS



115200 8N1



After establishing the serial connection between the VideoRAID SR and your workstation, the next step is to use the Telnet emulation tool to configure the VideoRAID SR. Configuration includes disabling DHCP and configuring a new IP address.
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HyperTerminal Configuration To access the VideoRAID SR using a Telnet emulation tool (HyperTerminal):



1. From a Windows system, select Start > All Programs > Accessories > Communications > HyperTerminal and click on HyperTerminal. The Connection Description dialog box opens. 2. Type in the name of your connection and click OK. The Connect To dialog box opens 3. Click the Connect Using pop-up menu and select COM1, leave the remaining default settings, and click OK. The COM1 Properties dialog box opens. 4. Set the serial management port settings in the COM1 Properties dialog box to the following settings. Serial Management Port Settings Bits per second



115200



Data Bits



8



Parity



None



Stop Bits



1



Flow Control



None



5. Click Apply and then click OK.
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A blank HyperTerminal window opens. 6. Press Enter twice. The HyperTerminal Login window opens.



7. Type the following into the HyperTerminal login window at the Login and Password prompts: -



administrator



-



password



8. Press Enter. 9. Type menu at the administrator@cli prompt and press Enter. The CLI main menu opens.
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10. Using the arrow keys, navigate to the Network Management choice and press Enter.



The Network Port Summary window opens. Because the VideoRAID SR is not on a DHCP enabled network, zeroes display in the IP address field.
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11. Press Enter. The Management Port Info window opens.



12. Press Enter to navigate to the Management Port Settings window. The Management Port Settings window opens.
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Before entering a new IP address for the VideoRAID SR, DHCP must be disabled. -



Using the tab and arrow keys, navigate to the DHCP menu selection and press spacebar to toggle DHCP to Disabled. The Static IP settings then appear on screen.



n



-



Tab to the DHCP selection and press Enter. DHCP is disabled.



-



Tab to the IP Address selection and backspace over the existing entry.



-



Enter your IP address using the correct format, for example, 172.20.14.234.



This IP address is used to access the Avid VideoRAID SR configuration tool. Note and save this IP address for future use. -



Tab to the Subnet Mask Address selection and backspace over the existing entry.



-



Enter your subnet mask address using the correct format, for example, 255.255.255.255. (Optional) If necessary, repeat these steps for the Gateway IP Address and the DNS Server IP Address fields.
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n



A dialog box displays a warning about an invalid IP address, unless the Gateway and DNS Server IP addresses have something entered, for example 0.0.0.0. DO NOT leave these fields completely blank.



-



Using the tab and arrow keys, navigate to the Save Settings selection and press Enter to save the new settings.



A warning message displays in the HyperTerminal window.
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13. Press Y to accept the changes. The Management Port Settings window displays the new IP address and notifies you the changes have been saved.



14. Using the tab and arrow keys, navigate to the Return to Previous Menu and press Enter. Repeat this step until you return to the main menu. 15. Using the tab and arrow keys, navigate to the Return to CLI choice and Press Enter. 16. Type logout at the administrator@cli prompt.
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17. Restart your VideoRAID SR. After your workstation restarts, the IP address now displays in the LCD module on the front of the VideoRAID SR storage enclosure. Use this IP address to access the Avid VideoRAID SR configuration tool, see “Using the Avid VideoRAID SR Configuration Tool” on page 58.



n



Depending on your configuration, it can take anywhere from three to five minutes for the new IP address to appear in the CLI Management Port Settings window after restarting your workstation. You can access the VideoRAID SR configuration tool once the IP address displays in the LCD module on the front of the VideoRAID SR 18. 19. 20.



Working with the Storage Network When you log into the Avid Configuration Tool, you access a specific Avid VideoRAID SR enclosure. See “Accessing the Avid VideoRAID SR Configuration Tool” on page 55. The Storage Network feature enables you to access all of the Avid VideoRAID SR enclosures with a Management Port connection to your network. Each Avid VideoRAID SR enclosure is identified by its Management Port IP address. Storage Network functions include: •



Viewing other enclosures



•



Updating the list of enclosures



•



Logging into a enclosure



•



Hiding the other enclosures



Viewing Other Enclosures To view the other Avid VideoRAID SR enclosures on the Storage Network:



1. Click Storage Network in the Header. 2. Click the Show Network Enclosures popup option. The list shows all enclosures on the network at the time the user interface was started.
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Updating the List of Enclosures To update the list of the Avid VideoRAID SR enclosures on the Storage Network:



t



Click the Discover button at the bottom of the enclosure list.



Logging into a Enclosure To log into any of the displayed Avid VideoRAID SR enclosures:



1. In Tree View, click the Enclosure icon of the enclosure you want to see. If your user name and password do not match the enclosure you are logging into, the log in screen appears. 2. Log into the new enclosure, as needed.



Hiding the Other Enclosures To hide the other Avid VideoRAID SR enclosures the Storage Network:



1. Click Storage Network in the Header. 2. Click the Hide Network Enclosures popup option.



Working with Enclosures A Avid VideoRAID SR enclosure is identified by its IP address. Enclosure functions include:
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•



Viewing Enclosure Information



•



Saving System Service Report



•



Setting an Alias for the Enclosure



•



Setting Enclosure Date and Time



•



Viewing the Runtime Event Log



•



Saving the Runtime Event Log



•



Clearing the Runtime Event Log



•



Viewing NVRAM Events



•



Saving NVRAM Events



•



Clearing NVRAM Events



•



Viewing Current Background Activities



•



Viewing Scheduled Activities



Working with Enclosures



•



Scheduling an Activity



•



Deleting a Scheduled Activity



Viewing Enclosure Information To view information about a enclosure, click the Enclosure icon in Tree View. Management View displays the enclosure information.



Saving System Service Report To save a System Service Report as a text file on your host computer:



1. In Tree View, click the Enclosure icon. 2. On the Information tab, click the Save button. The Save File window appears. 3. Navigate to the folder location in which to save the configuration and status file. 4. Specify a file name in the File Name text field. “enclosureinfo” is the default file name.



n



The System Service Report is in Comma Separated Value (CSV) format. Appending “.csv” to the file name allows you to open the file easily in Microsoft Excel or similar spreadsheet program. 5. Click the Save button. The System Service Report is saved to the specified location.



Setting an Alias for the Enclosure An alias is an optional name you can give to the Avid VideoRAID SR to make it easier to identify in the Avid Configuration Tool. The default is “Avid.” To set an alias for this enclosure:



1. In Tree View, click the Enclosure icon. 2. In Management View, click the Settings tab. 3. Enter a name into the Alias field. Maximum of 48 characters. Use letters, numbers, space between words, and underscore. 4. Click the Submit button.
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Setting Enclosure Date and Time To set a Date and Time for this enclosure:



1. In Tree View, click the Enclosure icon. 2. In Management View, click the Settings tab drop down menu and select Date and Time Settings. 3. Under Enclosure Date, select the Month and Day from the drop down menus. 4. Type the current year into the Year field. 5. Under Enclosure Time, select the Hour, Minutes and Seconds from the drop-down menus. 6. Click the Submit button.



Viewing the Runtime Event Log Runtime Events lists information about the 1023 most recent runtime events recorded since the system was started. To view runtime events:



1. In Tree View, click the Enclosure icon. 2. In Management View, click the Events tab drop-down menu and select Runtime Events. The following table lists the columns in the Event Frame and their descriptions:
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Column



Description



Item Number



A consecutive decimal number assigned to a specific event.



Device



Controller, logical drive, physical drive, port, etc.



Event ID



The hexadecimal number that identifies the specific type of event.



Severity



Information, Warning, Minor, Major, Critical, and Fatal. The severity level is user-specified. See “Setting Up User Event Subscriptions” on page 80.



Time



Time and date of the occurrence



Description



A brief description of the event.



Working with Enclosures



3. Click the link at the top of the column by which you want to sort the events. After you click the item, a triangle icon appears. t



If the triangle points upward, the column is sorted low-to-high or old-to-new.



t



If the triangle points downward, the column is sorted high-to-low or new-to-old.



Click the link a second time to change to flip the triangle and reverse the sort sequence.



Saving the Runtime Event Log To save the runtime event log as a text file:



1. In Tree View, click the Enclosure icon. 2. In Management View, click the Events tab drop-down menu and select Runtime Events. 3. Click the Save Event Log button. 4. In the File Download dialog box, click the Save button. 5. In the Save dialog box, name the file, navigate to the folder where you want to save the log file, and click the Save button.



n



The System Service Report is in Comma Separated Value (CSV) format. Appending “.csv” to the file name allows you to open the file easily in Microsoft Excel or similar spreadsheet program.



Clearing the Runtime Event Log To clear the runtime event log:



1. In Tree View, click the Enclosure icon. 2. In Management View, click the Events tab drop-down menu and select Runtime Events. 3. Click the Clear Event Log button. 4. In the Confirmation dialog box, type confirm and click the OK button.



Viewing NVRAM Events NVRAM Events lists information about the 63 most recent important events. NVRAM events are stored in non-volatile memory. To view runtime events:



1. In Tree View, click the Enclosure icon. 2. In Management View, click the Events tab drop-down menu and select System Events in NVRAM. The following table lists the columns in the Event Frame and their descriptions: 75
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Column



Description



Item Number



A consecutive decimal number assigned to a specific event.



Device



Controller, logical drive, physical drive, port, etc.



Event ID



The hexadecimal number that identifies the specific type of event.



Severity



Information, Warning, Minor, Major, Critical, and Fatal. The severity level is user-specified. See “Setting Up User Event Subscriptions” on page 80.



Time



Time and date of the occurrence



Description



A brief description of the event.



3. Click the link at the top of the column by which you want to sort the events. After you click the item, a triangle icon appears. t



If the triangle points upward, the column is sorted low-to-high or old-to-new.



t



If the triangle points downward, the column is sorted high-to-low or new-to-old.



Click the link a second time to change to flip the triangle and reverse the sort sequence.



Saving NVRAM Events To save the NVRAM event log as a text file:



1. In Tree View, click the Enclosure icon. 2. In Management View, click the Events tab drop-down menu and select System Events in NVRAM. 3. Click the Save Event Log button. The Save File window appears. 4. Navigate to the folder location in which to save the event log file. 5. Specify a file name in the File Name text field. “eventlog” is the default file name.



n



The System Service Report is in Comma Separated Value (CSV) format. Appending “.csv” to the file name allows you to open the file easily in Microsoft Excel or similar spreadsheet program. 6. Click the Save button. The Event Log is saved to the specified location.
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Clearing NVRAM Events To clear the NVRAM event log:



1. In Tree View, click the Enclosure icon. 2. In Management View, click the Events tab drop-down menu and select System Events in NVRAM. 3. Click the Clear Event Log button. 4. In the Confirmation dialog box, type confirm and click the OK button.



Viewing Current Background Activities To view the current background activities:



1. In Tree View, click the Enclosure icon. 2. In Management View, click the Background Activities tab. A list of current background activities appears, including: -



Rebuild



-



Synchronization



-



Redundancy Check



-



Transition



-



Initialization



Viewing Scheduled Activities To view scheduled activities for this enclosure:



1. Click the Enclosure icon Tree View. 2. Click the Scheduler tab in Management View.



Scheduling an Activity To set a scheduled activity for this enclosure:



1. Click the Enclosure icon Tree View. 2. From the drop-down menu on the Scheduler tab, select an item. 3. In the Scheduler dialog box, check the Enable This Schedule box. 4. Select a start time, in 24-hour time format.
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5. Select one of the following Recurrence Pattern options.



n



t



Daily—Enter the number of days between events.



t



Weekly—Enter the number of weeks between events and select which days of the week.



t



Monthly—Select either a day of the month, or occurrence of a specific weekday, and then select the months in which you want the activity to occur.



If you select a higher number than there are days in the current month, the actual start date will occur at the beginning of the following month. 6. Specify a Start From date. The default is the current date. 7. Select one of the following End On date options: t



No End Date—The task is perpetual.



t



End After x times—Specifies the number of occurrences for this activity.



t



Until date—The default is the current date.



8. (Optional) For Redundancy Check only, in the “Redundancy Check Options” area, do the following: a.



b.



n



Select one or both of the following options: t



Auto Fix—This feature attempts to repair the problem when it finds an error.



t



Pause on Error—This feature stops the process when it finds an error.



Check the boxes beside the logical drives to which this activity will apply.



You can schedule only ONE Redundancy Check for each logical drive. 9. Click the Submit button. The scheduled activity is added to the Schedule List.



Deleting a Scheduled Activity To delete a scheduled activity for this enclosure:



1. Click the Enclosure icon Tree View. 2. From the drop-down menu on the Scheduler tab, select Delete Schedules. 3. Check the box to the left of the schedule you want to delete. 4. Click the Submit button. The scheduled activity is removed from the Schedule List
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Managing Users User Management includes all functions dealing with user accounts. Functions include: •



Viewing User Information



•



Configuring User Settings



•



Configuring Your Own User Settings



•



Setting Up User Event Subscriptions



•



Changing Another User’s Password



•



Changing Your Own Password



•



Creating a User



•



Deleting a User



•



Viewing User Sessions



•



Logging out Other Users



Viewing User Information To view a list of users, their status, access privileges, display name, and E-mail address:



1. Click the Enclosure icon in Tree View. 2. Click the Administrative Tools icon. 3. Click the User Management icon. The Information tab appears in Management View.



Configuring User Settings To change settings of other users:



1. Log into the Avid Configuration Tool as the Administrator or a Super User. 2. Click the Enclosure icon in Tree View. 3. Click the Administrative Tools icon. 4. Click the User Management icon. 5. On the Information tab, click the link of the user whose settings you want to change. The Settings screen for the selected user displays.
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6. Configure the following settings as needed. Setting



Description



Enable



Enables or disables the user in the system.



Display Name



The name that is displayed when the user is logged into Avid Configuration Tool.



E-mail



The user’s E-mail address.



Privilege



The user’s Privilege level. For a description of Privilege levels, see “Creating a User” on page 82.



7. Click the Submit button. The Administrator or Super User can change another user’s password. See “Changing Another User’s Password” on page 81 for more information.



Configuring Your Own User Settings To change your own user settings:



1. Log into the Avid Configuration Tool under your own user name. 2. Click the Enclosure icon in Tree View. 3. Click the Administrative Tools icon. 4. Click the User Management icon. 5. Click the Settings tab in Management View. 6. Enter or change the display name or mail address. 7. Click the Submit button.



Setting Up User Event Subscriptions An event subscription enables a user to receive E-mail messages about events taking place in the Avid VideoRAID SR enclosure. To make or change user event subscriptions:



1. Click the Enclosure icon in Tree View. 2. Click the Administrative Tools icon. 3. Click the User Management icon. 4. Click the Event Subscription tab in Management View. 80
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5. Select “Enable Event Notification” and click the radio box to enable event notification. 6. Under the subheadings, select the lowest level of Severity to be reported for each event. The selected level plus all higher levels of Severity will be reported. Severity Level



Description



Information



Information only, no action is required.



Warning



User can decide whether or not action is required.



Minor



Action is needed but the condition is not a serious at this time.



Major



Action is needed now.



Critical



Action is needed now and the implications of the condition are serious.



Fatal



A Non-Recoverable error or failure has occurred.



None



Deactivates this event for notification purposes



7. Click the Submit button. The user’s account must have an E-mail address. See “Configuring User Settings” on page 79. For information about the E-mail service, see “Configuring E-mail Settings” on page 85. To send a test message to the E-mail address in the listed under General Info, click the Test Email button.



Changing Another User’s Password To change a user’s password:



1. Log into the Avid Configuration Tool as the Administrator or a Super User. 2. Click the Enclosure icon in Tree View. 3. Click the Administrative Tools icon. 4. Click the User Management icon. 5. In the list of users, click the link of the user whose settings you want to change. The Settings screen for the selected user displays. 6. Click the Password tab in Management View. 7. Enter the new password in the New Password field. 81
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8. Enter the new password in the Retype Password field. 9. Click the Submit button.



Changing Your Own Password To set or change your own password:



1. Log into the Avid Configuration Tool under your own user name. 2. Click the Enclosure icon in Tree View. 3. Click the Administrative Tools icon. 4. Click the User Management icon. 5. Click the Password tab in Management View. 6. Enter the current password in the Old Password field. If you do not have a password, leave this field blank. 7. Enter the new password in the New Password field. 8. Enter the new password in the Retype Password field. 9. Click the Submit button.



Creating a User To create a user:



1. Log into the Avid Configuration Tool as the Administrator or a Super User. 2. Click the Enclosure icon in Tree View. 3. Click the Administrative Tools icon. 4. Click the User Management icon. 5. Click the Create tab in Management View. 6. Enter a user name in the User Name field. 7. Enter a password for this user in the New Password and Retype Password fields. A password is optional. If you do not specify a password, log into the Avid Configuration Tool with the User Name and leave the password field blank. 8. (Optional) Enter a display name in the Display Name field. 9. Enter the user's E-mail address in the E-mail Address field. An E-mail address is required in order to receive E-mail event notification. 10. Select a privilege level from the Privilege drop-down menu.
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For definitions of each privilege level, see the following table of User Privileges. User Privilege



Description



View



Allows the user to see all status and settings but not to make any changes.



Maintenance



Allows the user to perform maintenance tasks including Rebuilding, PDM, Media Patrol, and Redundancy Check.



Power



Allows the user to create (but not delete) disk arrays and logical drives, change RAID levels, change stripe size; change settings of components such as disk arrays, logical drives, physical drives, and the controller.



Super



Allows the user full access to all functions including create and delete users and changing the settings of other users, and delete disk arrays and logical drives. The default “administrator” account is a Super User.



11. Check the Enabled box to enable this user on this enclosure. 12. Click the Submit button.



Deleting a User There will always be at least one Super User account. You cannot delete the user account you used to log in. To delete a user:



1. Log into the Avid Configuration Tool as the Administrator or a Super User. 2. Click the Enclosure icon in Tree View. 3. Click the Administrative Tools icon. 4. Click the User Management icon. 5. Click the Delete tab in Management View. 6. Check the box to the left of the user you want to delete. 7. Click the Submit button. 8. Click OK in the confirmation box.
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Viewing User Sessions To view the current sessions:



1. Click the Enclosure icon in Tree View. 2. Click the Administrative Tools icon. 3. Click the User Management icon. 4. Click the Sessions tab in Management View.



Logging out Other Users To logout other users:



1. Log into the Avid Configuration Tool as the Administrator or a Super User. 2. Click the Enclosure icon in Tree View. 3. Click the Administrative Tools icon. 4. Click the User Management icon. 5. Click the Sessions tab in Management View. 6. Check the box to the left of the user you want to log out. 7. Click the Logout button. 8. Click OK in the confirmation box.
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Configuring Avid VideoRAID SR Ethernet Port Settings You can use either DHCP or static IP addressing with Avid VideoRAID SR. To make changes to the Avid VideoRAID SR Ethernet Port settings:



1. Click the Enclosure icon in Tree View. 2. Click the Administrative Tools icon. 3. Click the Network Management icon. 4. Click the Port Configuration link in management View. 5. Do one of the following: t



To enable DHCP, check the DHCP box.



t



To manually configure network settings, specify the following: -



Primary IP address



-



Primary subnet mask



-



Default gateway IP address



-



Primary DNS server IP address



6. Click the Submit button.



Managing Software Services Software Services include the following functions: •



Configuring E-mail Settings



•



Configuring Web Server Settings



Configuring E-mail Settings The E-mail sends notification messages to users. See “Setting Up User Event Subscriptions” on page 80. To configure E-mail service settings:



1. Click the Enclosure icon in Tree View. 2. Click the Administrative Tools icon. 3. Click the E-mail Setting link in Management View.
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4. Enter the IP address for your SMTP server. 5. Enter server port number for your SMTP server. The default port is 25. 6. Select Yes to enable SMTP authentication or No to disable. 7. If you chose Yes for SMTP authentication, enter a Username and Password in the fields provided. 8. Enter an E-mail sender address (example: [email protected]). 9. Enter an E-mail subject (example: Avid VideoRAID SR Status). 10. Click the Submit button. To send one test message to the User currently logged into the Avid Configuration Tool:



1. Under Test E-mail, check the “Send A Test E-mail” box. 2. Click the Submit button. If you do not receive the Test E-mail message, see your Network Administrator for assistance with the mail server setup, E-mail accounts, and other issues. To change the Startup Setting:



1. Under Startup Type, select one of the following: t



Click the Automatic option to start the service automatically during system startup. Recommended.



t



Click the Manual option to start the service manually (the service does not start during system startup).



2. Click the Submit button. To stop the E-mail service:



1. Click the Stop button. 2. Click OK in the confirmation box. To start or restart the E-mail service



t
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Click the Start or Restart button.
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Configuring SLP Settings Avid VideoRAID SR's SLP service discovers services available over the Internet. To configure SLP service settings:



1. Click the Enclosure icon in Tree View. 2. Click the Administrative Tools icon. 3. Click the Software Management icon. 4. Click the SLP link. 5. Select the Startup Type: t



Automatic—(Recommended) Starts the service automatically during system startup.



t



Manual—Starts the service manually (the service does not start during system startup).



6. Click the Submit button. To stop the SLP service:



1. Click the Stop button. 2. Click OK in the confirmation box. To start or restart the SLP service:



t



Click the Start or Restart button.



Configuring Web Server Settings Avid VideoRAID SR’s Web Server service connects the Avid VideoRAID SR user interface to the Avid VideoRAID SR enclosure though your browser. To configure Web Server settings:



1. Click the Enclosure icon in Tree View. 2. Click the Administrative Tools icon. 3. Click the Web Server Setting link in Management View. 4. Enter the HTTP Port number. The default is port 80. 5. Enter Session Time Out interval. This setting causes the Avid Configuration Tool to time-out after a period of inactivity. 24 minutes is the default. The range is 1 to 1440 minutes (one day). 87
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6. If you want to use a secure connection, check the Enable SSL box. 7. If you checked the Enable SSL box, enter a HTTPS Port number. The default is port 443. 8. Click the Submit button. 9. Click OK in the confirmation box to restart the Web Server service with your changes. To Change the Startup Setting:



1. Under Startup Type: t



Click the Automatic option to start the service automatically during system startup. Recommended.



t



Click the Manual option to start the service manually (the service does not start during system startup).



2. Click the Submit button. To stop the Web Server service:



1. Click the Stop button. 2. Click OK in the confirmation box. To start or restart the Web Server service:



t



Click the Start or Restart button.



Importing the Avid Configuration File The Software Management–Import tab enables you to import the Avid Configuration File to the Avid VideoRAID SR enclosure. The configuration file should only be imported in the event that the RAID controller is in a failed or unrecoverable state, and at the instruction of Avid Technical Support.



c



Loading the configuration file deletes all existing data on the Avid VideoRAID SR. This procedure should be performed only with the assistance of an Avid Customer Support Representative. To import the Avid Configuration File to this enclosure:



1. Click the Enclosure icon in Tree View. 2. Click the Administrative Tools icon. 3. Click the Software Management icon. 4. Click the Import tab.
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5. Under the Type drop-down list, select Configuration Script. 6. Do one of the following: t



Enter the name of the file to be imported.



t



Or, click the Browse button to search for the file.



7. Click the Submit button. 8. Click the Next button. If the imported file is a valid configuration script, a warning appears to inform you that it will overwrite the previous settings. 9. In the Warning box, click the OK button. All existing configuration and user data is erased, and the new configuration is applied to the Avid VideoRAID SR.



n



The Description box is dimmed. Description is disabled for configuration scripts.



Updating the Firmware Update the firmware for the VideoRAID SR storage enclosure A firmware update consists of the following actions: •



Downloading the Firmware Image File



•



Restarting the Avid VideoRAID SR



If you need to update your firmware on your Avid VideoRAID SR for any reason, use the following procedure. In general, updating firmware is a non-destructive operation, but it is wise to follow all precautions to ensure that you do not lose your data.



c



Before performing any firmware updates, be sure you have backed up your data to a different location.



Downloading the Firmware Image File Go to the Avid support website at http://support.avid.com/ and download the latest firmware image (.img) file to your computer.



Updating Firmware From Your Computer To update the firmware from your computer:



1. Click the Enclosure icon in Tree View. 2. Click the Administrative Tools icon. 89
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3. Click the Software Management icon. 4. Click the Firmware Update tab. 5. Do one of the following actions: t



Click the Download Flash File from Local File through HTTP option, then click the Next button.



t



From the Firmware Update tab drop-down menu, select Download from Local File.



6. Enter the filename of the Firmware Update file in the field provided. Or, click the Browse button and select the Firmware Update file in the Open dialog box. 7. Click the Submit button. 8. When the download is completed, click the Next button. A popup message appears to warn you not to reboot the Avid VideoRAID SR during the firmware update procedure. 9. In the popup message, click the OK button. The update progress displays. Then a popup message appears to tell you to reboot the Avid VideoRAID SR. 10. In the popup message, click the OK button. 11. Restart the Avid VideoRAID SR. See “Restarting the Avid VideoRAID SR” on page 90.



n



After you click the Submit button, if the Avid Configuration Tool displays this message: error transferring image, you entered an incorrect file name or an incorrect location. Check the information and try again.



Restarting the Avid VideoRAID SR



w



Do not restart the Avid VideoRAID SR during a firmware upgrade procedure. Wait until the upgrade is one and you are prompted to restart. To restart the Avid VideoRAID SR enclosure:



1. Click the Enclosure icon in Tree View. 2. Click the Administrative Tools icon. 3. Click the Shutdown link in Management View. 4. A Shutdown or Restart tab appears. 5. On the Shutdown or Restart tab, select Restart from the drop-down menu. 6. Click the Submit button. 7. In the warning box, click the OK button. 90



Clearing Statistics



8. In the confirmation box, type the word confirm in the field provided. 9. Click the OK button. 10. When the controller shuts down, the connection to the Avid Configuration Tool is lost. 11. Wait for two to three minutes. 12. In your browser, log into the Avid Configuration Tool once again. If you cannot log in, wait for 30 seconds, and try again.



n



If you continue to experience difficulty logging into the system, see “Troubleshooting” on page 107 for more information on diagnosing problems.



Clearing Statistics The Clear Statistics function clears statistical data on the controller, Serial Attached SCSI ports, physical drives, and logical drives. To clear statistical data:



1. Click the Enclosure icon in Tree View. 2. Click the Administrative Tools icon. 3. Click the Clear Statistics link. The Clear Statistics tab appears in Management View. 4. Click the Submit button. 5. In the confirmation box, type the word confirm in the field provided. 6. Click the OK button.



Managing the Avid VideoRAID SR RAID Controller The RAID controller is the heart of the Avid VideoRAID SR. Management of the RAID controller includes the following functions: •



Viewing Controller Information



•



Locating the Controller
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Viewing Controller Information To view controller information:



1. Click the Enclosure icon in Tree View. 2. Click the Controller icon. The controller information appears under the Information tab in Management View. Controller information includes: -



Controller ID



-



Alias – if assigned



-



Model – if applicable



-



Status – OK means normal



-



Readiness Status – Active or Standby



-



Locate – Click the button to locate the controller. See “Locating the Controller” on page 92



At this time, the Avid VideoRAID SR will always show that the second controller is “Missing.”



Locating the Controller To identify a specific controller in the Avid VideoRAID SR enclosure:



1. Click the Enclosure icon in Tree View. 2. Click the Controller icon. 3. In Management View, click the Locate Controller button. 4. The Controller Dirty Cache LED and Status LED, on the back of the Controller, flashes for one minute. See the following illustration.



115200 8N1



Status LED Dirty Cache LED
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Managing Enclosures Enclosure Management includes the following functions: •



Viewing the Enclosures



•



Locating an Enclosure



•



Viewing Enclosure Topology



•



Viewing Enclosure Information



•



Viewing FRU VPD Information



•



Silencing the Alarm



•



Configuring Alarm Settings



•



Testing the Alarm



Viewing the Enclosures To view information about the enclosures:



1. Click the Enclosure icon in Tree View. 2. Click the Enclosures icon. The following information is shown: -



Enclosure ID number



-



Enclosure Type



-



Operational Status



-



Status Description (specific components in need of attention, if any)



Locating an Enclosure To locate an enclosure (enclosure):



1. Click the Enclosure icon in Tree View. 2. Click the Enclosures icon.
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3. Click the Locate Enclosure button. The Disk Status LEDs on the front of the enclosure flashes for one minute. Drive Carrier LEDs



Disk status



Power / Activity



Viewing Enclosure Topology To view Enclosure Topology:



1. Click the Enclosure icon in Tree View. 2. Click the Enclosures icon. 3. Click the Topology tab in Management View. Enclosure topology refers to the manner in which the data paths among the enclosures are connected: The logical connections for these arrangements are shown the Enclosure Topology tab. The physical connections for these arrangements are discussed in “Installing the Avid VideoRAID SR” on page 25.
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Viewing Enclosure Information To view enclosure information:



1. Click the Enclosure icon in Tree View. 2. Click the Enclosures icon. 3. Click the Enclosure icon. Enclosure information appears the Information tab in Management View. You can monitor power supplies, cooling units, enclosure temperatures and voltages.



Adjustable items You can set or adjust the following items: •



Enclosure Warning and Critical temperature thresholds



•



Controller Warning and Critical temperature thresholds



See “Configuring Enclosure Settings” on page 95. For information on Enclosure problems, see “Troubleshooting” on page 107.



Configuring Enclosure Settings To configure Enclosure settings:



1. Click the Enclosure icon in Tree View. 2. Click the Enclosures icon. 3. Click the Enclosure icon. 4. Click the Settings tab in Management View. 5. Enter a value in the following fields as necessary, in degrees Celsius: -



Enclosure Warning Temperature Threshold



-



Enclosure Critical Temperature Threshold



-



Controller Warning Temperature Threshold



-



Controller Critical Temperature Threshold



6. Click the Submit button. The changes take effect immediately.
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Viewing FRU VPD Information The Vital Product Data (VPD) information about Field Replaceable Units (FRU) in the enclosure is displayed in the FRU VPD tab. To view FRU VPD information:



1. Click the Enclosure icon in Tree View. 2. Click the Enclosures icon. 3. Click the Enclosure icon. 4. Click the FRU VPD tab in Management View. Use this information when communicating with Technical Support and when ordering replacement units. For contact information, see “If You Need Help” on page 14.



Silencing the Alarm The alarm sounds to inform you that the Avid VideoRAID SR needs attention. See “Avid VideoRAID SR is Beeping” on page 108 for more information. To silence the alarm for the current trigger event:



1. Click the Enclosure icon in Tree View. 2. Click the Enclosures icon. 3. Click the Enclosure icon. 4. Click the Alarm tab in Management View. 5. Click the Mute button. The alarm goes silent. If another trigger event occurs, the alarm will sound again. To silence the alarm for all trigger events, disable it under “Configuring Alarm Settings” on page 96 The alarm can also be silenced from the LCD panel mounted to the enclosure.



Configuring Alarm Settings To configure alarm settings:



1. Click the Enclosure icon in Tree View. 2. Click the Enclosures icon. 3. Click the Enclosure icon. 4. In Management View, from the Alarm tab drop-down menu, select Settings. 96
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5. Check the Alarm Enable box to enable the alarm. Uncheck the Alarm Enable box if you do not want the alarm to sound. 6. Click the Submit button. Testing the Alarm You must enable the alarm before you can test it. To test alarm function:



1. Click the Enclosure icon in Tree View. 2. Click the Enclosures icon. 3. Click the Enclosure icon. 4. Click the Alarm tab in Management View. 5. Click the Sound button. The alarm sounds for one minute.



Managing Physical Drives Managing Physical Drives deals with the physical disk drives installed in the Avid VideoRAID SR enclosure, including the following functions: •



Viewing a List of Physical Drives



•



Identifying a Physical Drive



•



Viewing Physical Drive Information



•



Viewing Physical Drive Statistics



•



Clearing Stale and PFA Conditions



Viewing a List of Physical Drives To view a list of physical drives in this enclosure:



1. Click the Enclosure icon in Tree View. 2. Click the Enclosures icon. 3. Click the Enclosure icon. 4. Click the Physical Drives icon. The list of physical drives appears in Management View.
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Identifying a Physical Drive To identify physical drive in the Avid VideoRAID SR enclosure:



1. Click the Enclosure icon in Tree View. 2. Click the Enclosures icon. 3. Click the Enclosure icon. 4. Click the Physical Drives icon. 5. In Management View, click the physical drives in the graphic. The location of the physical drive is highlighted in the Enclosure Front View diagram.



Viewing Physical Drive Information To view physical drive information:



1. Click the Enclosure icon in Tree View. 2. Click the Enclosures icon. 3. Click the Enclosure icon. 4. Click the Physical Drives icon. 5. Click a Physical Drive icon. Useful information provided here includes: -



The location of the physical drive is highlighted in the Enclosure Front View diagram.



-



Operational Status – OK is normal. Can also show Rebuilding, Forced Online, Forced Offline, Transition Running, Media Patrol Running, Stale, PFA, Offline, or Dead.



-



Configuration Status – The array to which the drive is assigned.



Viewing Physical Drive Statistics To view physical drive statistics:



1. Click the Enclosure icon in Tree View. 2. Click the Enclosures icon. 3. Click the Enclosure icon. 4. Click the Physical Drives icon. 5. Click a Physical Drive icon. 6. From the drop-down menu on the Information tab, select Statistics. 98
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Clearing Statistics To clear statistics, see “Clearing Statistics” on page 91.



Clearing Stale and PFA Conditions The Clear tab only appears when those conditions are present.



c



•



Stale – The physical drive contains obsolete disk array information.



•



PFA – The physical drive has errors resulting in a prediction of failure.



Be sure you have corrected the condition first before you clear it. To clear a Stale or PFA status from a physical drive:



1. Click the Enclosure icon in Tree View. 2. Click the Enclosures icon. 3. Click the Enclosure icon. 4. Click the Physical Drives icon. 5. Click a Physical Drive icon. 6. In Management View, click the Clear tab. 7. In the Confirmation box, click OK to confirm.



n



If a physical drive has both a Stale and a PFA condition, click the Clear tab once to clear the Stale condition, then click again to clear the PFA condition.



Managing Disk Arrays Disk Array Management includes the following functions: •



Viewing Disk Arrays



•



Rebuilding a Disk Array



Viewing Disk Arrays To view the disk arrays in this enclosure:



1. Click the Enclosure icon in Tree View. 2. Click the Disk Arrays icon. A list of disk arrays appears in Management View.
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Click the disk array link in the Device column to view information about a specific disk array. See the following figure.



Rebuilding a Disk Array When you rebuild a disk array, you are actually rebuilding the data on a physical drive replacement. When a disk drive fails, remove the disk drive from the array, install a new disk drive and use the following procedure to rebuild your array. When you rebuilding disk array, you can choose to either keep using the VideoRAID SR storage enclosure or you may pause your workflow until the rebuild completes. During an array rebuild, the priority of the VideoRAID’s resources go to rebuilding the array first, which means that performance may vary during the rebuilding process.
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Rebuilding Manually If a physical drive fails, identify and replace the drive, then rebuild the disk array. To rebuild the disk array:



1. Click the Enclosure icon in Tree View. 2. Click the Disk Arrays icon. 3. Select Start Rebuild from the drop-down menu in the Background Activity tab. 4. Select the Source physical drive. This is a remaining functional physical drive in the disk array. 5. Select the Target physical drive. This is the replacement physical drive. 6. Click the Submit button. The Disk Array Background Activity tab shows the rebuild progress on the replacement (target) physical drive. Depending the size of the physical disk involved, this process will take some time.



Managing Logical Drives Logical drives are made from disk arrays. In the Tree, you can see a graphic representation of the logical drives that belong to each array. You can see a summary of all logical drives in the enclosure under Logical Drive Summary. Logical drive management includes the following functions: •



Viewing Information for All Logical Drives



•



Viewing Logical Drive Statistics



•



Running Redundancy Check



•



Viewing the Logical Drive Check Table



Viewing Information for All Logical Drives To view information about all logical drives in a disk array:



1. Click the Enclosure icon in Tree View. 2. Click the Disk Arrays icon. 3. Click the Disk Array icon. 4. Click the Logical Drives icon 101
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The following figure displays the view in the Avid VideoRAID SR configuration tool.



You can also view specific information about each of the logical drives by clicking on the drive in the tree view and selection an option from the function tabs. For a Degraded or Offline logical drive, see “Disk Arrays: Critical and Rebuild Status” on page 125.



Viewing Logical Drive Statistics To view information for a single logical drive:



1. Click the Enclosure icon in Tree View. 2. Click the Disk Arrays icon. 3. Click the Disk Array icon. 4. Click the Logical Drives icon 5. Click the Logical Drive icon. 6. In Management View, from the drop-down menu on the Information tab, select Statistics.



Running Redundancy Check Redundancy Check is a routine maintenance procedure for fault-tolerant logical drives (those with redundancy) that ensures all the data matches exactly. Redundancy Check can also correct inconsistencies. You can also schedule a Redundancy Check. See “Scheduling an Activity” on page 77. 102
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To run Redundancy Check on a Logical Drive:



1. Click the Enclosure icon in Tree View. 2. Click the Logical Drive Summary icon. 3. Click the icon of the logical drive you want to Initialize. You can also start Redundancy check from the Enclosure icon Background Activities tab 4. From the drop-down menu on the Background Activities tab, select Redundancy Check. 5. To select Auto Fix, check the box. This feature attempts to repair the problem when it finds an error. 6. To select Pause On Error, check the box. This feature stops the process when it finds an error. If Auto Fix is also checked, the process stops only when it finds a non-repairable error. 7. Click the Submit button. To view the progress of the Redundancy Check, click the Background Activity tab.



Viewing the Logical Drive Check Table The Logical Drive Check Table displays errors related to a logical drive. Use this information to evaluate the integrity of the logical drive and to determine whether corrective action is needed. To View the tables:



1. Click the Enclosure icon in Tree View. 2. Click the Disk Arrays icon. 3. Click the Disk Array icon. 4. Click the Logical Drives icon 5. Click the Logical Drive icon. 6. Click the Check Table tab in Management View.
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7. Click the option for the table you want to see. Table Definition



Description



Read Check Table



Contains a list of read errors for this logical drive.



Write Check Table



Contains a list of write errors for this logical drive.



Inconsistent Block Table



Contains a list of inconsistent blocks for this logical drive. Parity data for RAID Level 5 identified by the Redundancy Check (a background function).



The default is All tables. If there are entries, they are listed as follows: Column



Description



Entry Number



A number assigned to each block of entry.



Table Type



Read Check, Write Check or Inconsistent Block.



Start Logical Block Address



LBA of the first block for this entry.



Count



Number of continuous blocks starting from this LBA.



Working with the Logical Drive Summary The Logical Drive Summary displays a list of all logical drives in the Avid VideoRAID SR enclosure. This list does not arrange the logical drives under the disk array to which they belong nor under the enclosure in which they are located. Logical Drive Summary includes the following functions: •



Viewing a List of All Logical Drives



•



Viewing Individual Logical Drive Information



Viewing a List of All Logical Drives To view a list of all logical drives in all enclosures:



1. Click the Enclosure icon in Tree View. 2. Click the Drive Summary icon.
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Viewing Individual Logical Drive Information To view individual logical drive information:



1. Click the Enclosure icon in Tree View. 2. Click the Drive Summary icon. 3. Click the Logical Drive icon. The information and location for the logical drive appear in Management View.
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4 Troubleshooting This chapter contains solutions for the most common problems you might during installation and configuration. You should always check online for the most up-to-date release notes or ReadMe because the online version is updated whenever new information becomes available. To view these online versions, select ReadMe from the Help menu or visit the Knowledge Base at www.avid.com/readme. •



Check each cable connection on every device.



•



Verify all cables are in proper working condition. Loose or broken cables are often the cause of errors or problems.



•



Check that devices are plugged into an AC outlet and are turned on before you add power to your computer.



•



Ensure you have the latest driver for your operating system and that the driver is installed.



If the problem persists, contact an Avid authorized representative. This chapter covers the following topics: •



Avid VideoRAID SR is Beeping



•



LEDs Display Amber or Red



•



Avid Configuration Tool Reports a Problem



•



Event Notification Response



•



Disk Arrays: Critical and Rebuild Status



•



Enclosure Problems



•



Connection Problems



•



Browser Does Not Connect to the Avid Configuration Tool



•



Unsaved Data in the Controller Cache
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Avid VideoRAID SR is Beeping Avid VideoRAID SR’s alarm has five different patterns, as shown in the following illustration.



Minor



Major



Critical



.25s .25s .25s



.25s



.25s



1x



.75s



.5s



.25s .25s .25s



.25s



.75s



2.5s



.25s



.25s



.5s



6s



.25s



.75s



Fatal



.25s



1s



.25s



1.25s



.25s



3s



2x



s



8



Warning



When you first power-up the Avid VideoRAID SR, it beeps twice to show normal operation. The audible alarm sounds at other times to inform you that the Avid VideoRAID SR needs attention. But the alarm does not specify the condition. When the alarm sounds: •



Check the front and back of Avid VideoRAID SR for red or amber LEDs, as described above.



•



If E-mail notification is enabled, check for new messages.



•



Check for yellow exclamation points (!) or red Xs in Tree View (see “Avid Configuration Tool Reports a Problem” on page 113).



•



Check the event log.



When a continuous tone sounds, there are multiple alarm patterns sounding at the same time. See “Setting Up User Event Subscriptions” on page 80 for more information about alarm severity levels. To make alarm settings or cancel an alarm using the Avid Configuration Tool, see “Silencing the Alarm” on page 96. 108
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LEDs Display Amber or Red Front Panel When the power is switched on, the LEDs on the front of the Avid VideoRAID SR will light up.



Power FRU Status Logical Drive Status



01 02



Controller 1 Activity Controller 2 Activity (Not supported) Controller Heartbeat



When boot-up is finished and the Avid VideoRAID SR is functioning normally: •



Controller Heartbeat LED blinks once every two seconds.



•



Power, FRU and Logical Drive LEDs display green continuously.



•



The RAID Controller LEDs flash green if there is activity on that controller.



LED States Steady Green



LED



Dark



Power



System Off



Normal



FRUa



System Off



Normal



Flashing Green



Amber



Red



Fan or PSU problem



Fan or PSU failed
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LED States (Continued) LED



Dark



Logical Drive



System Off



Steady Green



Flashing Green



Normal



Amber



Red



Logical Drive Logical Drive Critical Offline



Controller No Activity Activity



Activity



Controller System Heartbeat Off



Normalb



a. Field Replacement Unit: includes fan and power supply unit (PSU) b. The Controller Heartbeat LED blinks once every two seconds.



See “Disk Arrays: Critical and Rebuild Status” on page 125 for a discussion of critical and offline logical drives.



Drive Status Indicators There are two LEDs on each Drive Carrier. They report the presence of power and a disk drive, and the current condition of the drive. The Avid VideoRAID SR spins up the disk drives sequentially in order to equalize power draw during start-up. After a few moments the Power/Activity and Disk Status LEDs should display green. LED States Steady Green



Flashing Green



Power/Activity No Drive



Drive Present



Activity



Status



Drive OK



LED



Dark



No Power/No Drive



Amber



Red



Drive Rebuilding



Drive Error



See “Disk Arrays: Critical and Rebuild Status” on page 125 for a discussion of rebuilding and failed disk drives.
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Back of Enclosure When the FRU Status LED on Avid VideoRAID SR’s front panel shows Amber or Red, check the LEDs on the back of Avid VideoRAID SR. These LEDs give the status of the field replaceable units. SAS data ports Management port



MGMT



10101



Network port



UPS
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Power supply 1



Cooling unit 1



Cooling unit 2



Power supply 2



Under normal conditions, the power supply and fan LEDs should display green. LED States LED



Dark



Green



Amber



Red



Power supply



Not detected



OK



Fan failed



Failed



Fan



Not detected



OK



Wrong speed



Failed



To check a component’s installation, follow the same procedure as replacing the component, except that you reinstall the original component rather than a new one. In most cases, this action fixes a bad connection and allows Avid VideoRAID SR to detect the component. If this action does not correct the problem, replace the unit.
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The Controller Location LEDs, on the back of the Avid VideoRAID SR enclosure, will flash for one minute.



115200 8N1



Status LED Dirty Cache LED



Under normal conditions, the Controller Status LED (marked with Dirty Cache LED (marked with ) icon is dark.



icon) is green and the



LED States LED



Dark



Green



Amber



Status



no power



OK



Error



Dirty Cache



OK



Unsaved data in cache



Flashing Amber



OK



If the Controller Status LED is amber, restart the Avid VideoRAID SR. See “Restarting the Avid VideoRAID SR” on page 90. If the Controller Status LED continues to display amber after startup, contact Avid Technical Support. See “If You Need Help” on page 14. The Dirty Cache LED flashes during input/output operation. If the LED shines amber and the power is off, there is unsaved data in the cache. Do NOT power down the Avid VideoRAID SR while this LED is on. See “Browser Does Not Connect to the Avid Configuration Tool” on page 130 for more information.
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Avid Configuration Tool Reports a Problem The Avid Configuration Tool aids in troubleshooting your logical drives and enclosure by continuous monitoring and reporting to the User in the following ways: •



Displays yellow exclamation points (!) or red Xs in Tree View.



•



Sends E-mail messages, per your configuration.



•



Displays popup messages, per your configuration.



•



Keeps a record in the Event Log.



•



Keeps a record in the Event Log. 113
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•



Displays full information in Management View.



Also see these troubleshooting topics: •



“Event Notification Response” on page 114



•



“Disk Arrays: Critical and Rebuild Status” on page 125



Event Notification Response When you select Event Notification, the Avid Configuration Tool sends popup and/or E-mail messages regarding its status. The messages you see depend on your notification selection and what is currently happening in the Avid VideoRAID SR. See “Setting Up User Event Subscriptions” on page 80. The following tables cite:
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•



Reported Events – Events that require you to take action



•



Corrective Actions – The action you should take in response to the event



Event Notification Response



The following list describes event categories. •



Blower Events



•



BBU EventsBBU Events



•



Controller Events



•



Drive Interface Controller Events



•



Enclosure Events



•



Event Log Events



•



Host Interface Controller Events



•



Logical Drive Events



•



Media Patrol Events



•



Physical Disk Events



•



Power Supply Unit (PSU) Events



•



Power Supply Unit Fan(s) Events



•



Rebuild Events



•



Redundancy Check Events



•



Resource Events



•



SMART Events



•



Synchronization Events



•



System Events



Blower Events Reported Event



Corrective Action



Blowers have started.



Normal.



Blowers have stopped.



Verify that the cooling unit is properly installed. If the blower still does not turn, replace the blowers.



Blower speed is increased.



Check the Avid VideoRAID SR for overheating. See “Enclosure Problems” on page 126.



Blower speed is decreased.



Temporary overheat condition was corrected.



Blowers are NOT functioning.



Replace the blowers.



Blowers have been inserted.



Normal.
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Reported Event



Corrective Action



Blowers have been removed.



Reinstall the cooling unit(s). If the blowers does not turn, replace the blowers.



Blowers are functioning normally.



Normal.



Blowers are NOT installed.



Reinstall the cooling unit(s). If the blowers does not turn, replace the blowers. See “Rebuilding a Disk Array” on page 100.



Blower status is unknown.



Check for airflow out of the cooling unit. If there is none, check for proper installation.



BBU Events Reported Event



Corrective Action



BBU flushing has started.



Avid VideoRAID SR’s cache is being flushed.



BBU flushing has ended.



Avid VideoRAID SR’s cache has been flushed.



BBU flushing has failed.



Avid VideoRAID SR’s cache could not be flushed. Check your cache flush interval setting.



Controller Events Reported Event



Corrective Action



The controller has new crash information. Check the event logs. See “Viewing the Runtime Event Log” on page 74. Controller temperature is above the threshold/warning threshold.



The Avid VideoRAID SR controller is overheating. Check for airflow around and through the controller, and verify that all fans are working. Replace fans as needed.



Controller temperature is above the critical threshold.



The Avid VideoRAID SR controller is seriously overheating. Check for airflow around and through the controller, and verify that all fans are working. Replace fans as needed.



Drive Interface Controller Events Reported Event



Corrective Action



Drive-interface controller found.



Normal.
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Event Notification Response



Reported Event



Corrective Action



Drive-interface controller is NOT found.



Restart the Avid VideoRAID SR. See “Restarting the Avid VideoRAID SR” on page 90. If this message appears repeatedly, contact Technical Support. See “If You Need Help” on page 14.



Drive-interface diagnostics has passed.



Normal.



Drive-interface diagnostics has failed.



Restart the Avid VideoRAID SR. See “Restarting the Avid VideoRAID SR” on page 90. If this message appears repeatedly, contact Technical Support. See “If You Need Help” on page 14.



Drive-interface controller has generated a Drive-to-controller parity error. If this message appears repeatedly, general/data parity error. contact Technical Support. See “If You Need Help” on page 14.



Enclosure Events Reported Event



Corrective Action



Enclosure temperature is above the threshold/warning threshold.



The Avid VideoRAID SR is overheating. Check for airflow around and through the Avid VideoRAID SR, and verify that all fans are working. Replace fans as needed.



Enclosure temperature is above the critical The Avid VideoRAID SR is seriously overheating. Check for threshold. airflow around and through the Avid VideoRAID SR, and verify that all fans are working. Replace fans as needed. Enclosure temperature is within the normal range.



Normal.



Event Log Events Reported Event



Corrective Action



Event logging is enabled.



Event logging has been successfully enabled.



Event logging is disabled.



Event logging has been disabled.



Event log buffer is cleared in RAM.



The event log was cleared.



Event log buffer is cleared in NVRAM.



The non-volatile RAM event log was cleared.
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4 Troubleshooting



Host Interface Controller Events Reported Event



Corrective Action



Host-Interface controller has encountered Restart the Avid VideoRAID SR. See “Restarting the an unrecoverable error. Avid VideoRAID SR” on page 90. Host-Interface controller has received an abort-task/ abort task set/clear task set command.



Result of user action. Normal.



Host-Interface controller has received a LUN reset command.



Result of user action. Normal.



Host-Interface controller has received a bus reboot.



The Avid VideoRAID SR rebooted itself. If this message appears repeatedly, contact Technical Support. See “If You Need Help” on page 14.



Host-Interface controller has encountered An unidentified error occurred. If this message appears repeatedly, an unknown error. contact Technical Support. See “If You Need Help” on page 14. Host-Interface controller has encountered A Avid VideoRAID SR system error occurred. If this message a system error. appears repeatedly, contact Technical Support. See “If You Need Help” on page 14. Host-Interface controller has encountered Restart the Avid VideoRAID SR. See “Restarting the a fatal error. Avid VideoRAID SR” on page 90. If this message appears repeatedly, contact Technical Support. See “If You Need Help” on page 14. Host-Interface controller settings have changed.



Result of user action. Normal.



Logical Drive Events Reported Event



Corrective Action



Logical drive initialization has started.



Result of user action. Normal.



Logical drive initialization has completed. Logical drive is ready to use. Normal. Logical drive initialization has paused.



Initialization paused because of user intervention, schedule or a higher priority background activity.



Logical drive initialization has resumed.



Initialization has resumed again after a pause.



Logical drive initialization has stopped.



Initialization stopped because of user intervention, schedule or the logical drive was deleted or went critical or offline.
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Event Notification Response



Reported Event



Corrective Action



Logical drive initialization marks the logical drive offline.



Initialization failure due to a failed disk drive. Replace the disk drive, delete and recreate the logical drive. See “Installing Disk Drives” on page 31.



Logical drive initialization is aborted due to an internal error.



System resources are low. Reduce system load or restart the Avid VideoRAID SR. See “Restarting the Avid VideoRAID SR” on page 90.



Logical drive initialization is queued.



Initialization has been set manually or by schedule.



A new logical drive has been created.



Result of user action. Normal.



Logical drive has been deleted.



Result of user action. Normal.



Logical drive has been placed online.



The physical drives of the array are restored to online status.



Logical drive has been placed online. Possible data loss.



One or more physical drives in the array went offline. See “Disk Arrays: Critical and Rebuild Status” on page 125.



Logical drive has been set to critical.



One or more physical drives in the array went offline. See “Disk Arrays: Critical and Rebuild Status” on page 125.



Media Patrol Events Reported Event



Corrective Action



Media patrol is started.



Result of settings or user action. Normal.



Media patrol is completed.



Normal.



Media patrol is paused.



Media patrol paused because of user intervention, schedule or a higher priority background activity.



Media patrol is resumed.



Media patrol has resumed again after a pause.



Media patrol is stopped.



Media patrol stopped because of user intervention, schedule or the logical drive was deleted or went critical or offline.



Media patrol is aborted due to an internal error.



System resources are low. Reduce system load or restart the Avid VideoRAID SR. See “Restarting the Avid VideoRAID SR” on page 90.



Media patrol is queued.



Media patrol has been set manually or by schedule.



Media patrol is stopped internally.



Media patrol stopped because the disk array was deleted or removed.
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4 Troubleshooting



Reported Event



Corrective Action



Media patrol is started.



Result of settings or user action. Normal.



Media patrol is completed.



Normal.



Physical Disk Events Reported Event



Corrective Action



Physical disk is marked online.



Disk drive restored to normal operation.



Physical disk is marked online.



Disk drive removed from service due to errors. If necessary, try to force the disk online.



Physical disk is marked as dead.



Disk drive failure. Replace the disk drive. See “Installing Disk Drives” on page 31.



Physical disk has been reset.



Disk drive reset after error and should function normally.



Physical disk has been inserted.



A disk drive has been inserted into the Avid VideoRAID SR enclosure.



Physical disk has been removed.



A disk drive has been removed from the Avid VideoRAID SR enclosure.



Bad sector is found on physical disk.



Disk drive has a bad sector. The drive should remap around the bad sector. If this message appears repeatedly, replace the disk drive.



Error is detected in remap sectors.



Disk drive has a bad remap sectors. If this message appears repeatedly, replace the disk drive.



Command times out on physical drive.



Disk drive not responding to commands. If this message appears repeatedly, replace the disk drive.



Physical disk negotiation speed is decreased.



Disk drive had to reduce its data rate. If this message appears repeatedly, replace the disk drive.



Previously configured disk is no longer found.



Disk drive might have failed or was removed from the enclosure. Replace or reinstall the disk drive as needed.



A physical disk has encountered an unknown (non-ECC) media error.



Disk drive experienced an unknown error. If this message appears repeatedly, replace the disk drive.



A physical disk has encountered PFA condition.



A potentially faulty address or bad sector was found.
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Event Notification Response



Reported Event



Corrective Action



A configured dead physical drive has been The disk drive inserted into the Avid VideoRAID SR was marked as inserted. dead and will not work on the Avid VideoRAID SR. Replace the disk drive. A physical drive page 0/1 settings have been changed.



Result of settings or user action. Normal.



Physical disk is marked as dead due to removal/failure of reassign sectors/PFA condition/forced offline state.



Replace the disk drive.



Power Supply Unit (PSU) Events Reported Event



Corrective Action



PSU is not inserted/has been removed.



A power supply unit is missing from the Avid VideoRAID SR. Reinstall the power supply unit.



PSU is off.



A power supply unit is present but turned off. Turn on he power supply.



PSU is on.



Normal.



PSU is installed/operational and turned on.



Normal.



PSU is installed/operational and turned off.



A power supply unit is present but turned off. Turn on he power supply.



PSU is malfunctioning and turned on/off.



Replace the power supply unit.



PSU 12V/5V/3.3V power is out of the threshold range.



Replace the power supply unit.



PSU 12V/5V/3.3V power is within the range.



Normal.



Power Supply Unit Fan(s) Events Reported Event



Corrective Action



PSU fan has turned on.



Normal.
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4 Troubleshooting



Reported Event



Corrective Action



PSU fan has turned off.



Verify that the power supply is turned on. If the fan still does not turn, replace the power supply. See “Enclosure Problems” on page 126.



PSU fan speed increased.



Check the Avid VideoRAID SR for overheating. See “Enclosure Problems” on page 126.



PSU fan speed decreased.



Temporary overheat condition was corrected.



PSU fan is malfunctioning.



Replace the power supply.



PSU fan is functioning normally.



Normal.



PSU fan status is unknown.



Check for airflow out of the power supply. If there is none, check for proper installation and turn the power supply on.



Rebuild Events Reported Event



Corrective Action



Rebuild is started.



Result of settings or user action. Normal.



Rebuild is completed.



Normal.



Rebuild is paused.



Rebuild paused because of user intervention, schedule or a higher priority background activity.



Rebuild is resumed.



Rebuild has resumed again after a pause.



Rebuild is stopped.



Rebuild stopped because of user intervention, schedule or the logical drive was deleted or the target disk drive encountered an error. If rebuild stopped by user intervention, restart the rebuild. See q.



Rebuild stopped internally.



The logical drive is offline. See “Disk Arrays: Critical and Rebuild Status” on page 125.



Rebuild is aborted due to an internal error. System resources are low. Reduce system load or restart the Avid VideoRAID SR. See “Rebuilding a Disk Array” on page 100. Rebuild is queued.



Rebuild has been set manually or by schedule.



Rebuild marks logical drive synchronized Result of successful rebuild. Normal. upon rebuild completion.
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Event Notification Response



Redundancy Check Events Reported Event



Corrective Action



Redundancy Check is started.



Redundancy Check has started manually or by schedule.



Redundancy Check is completed.



Redundancy Check has finished.



Redundancy Check is paused.



Redundancy Check paused because of user intervention, schedule or a higher priority background activity.



Redundancy Check is resumed.



Redundancy Check has resumed again after a pause.



Redundancy Check is stopped.



Redundancy Check stopped because of user intervention, schedule or the logical drive was deleted or went critical or offline.



Redundancy Check is aborted due to internal error.



System resources are low. Reduce system load or restart the Avid VideoRAID SR. See “Restarting the Avid VideoRAID SR” on page 90.



Redundancy Check encountered inconsistent block(s).



Check the logical drive’s inconsistent block table. See “Viewing the Logical Drive Check Table” on page 103. Rebuild the disk array if necessary..



Redundancy Check task is queued.



Redundancy Check has been set manually or by schedule.



Redundancy Check task is stopped internally.



The logical drive is offline. See “Disk Arrays: Critical and Rebuild Status” on page 125.



Resource Events Reported Event



Corrective Action



Resource is NOT available.



System resources are low. Reduce system load or restart the Avid VideoRAID SR. See “Restarting the Avid VideoRAID SR” on page 90.



SMART Events Reported Event



Corrective Action



SMART error is received.



A disk drive reported a SMART error. If this message appears repeatedly, replace the disk drive.
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4 Troubleshooting



Synchronization Events Reported Event



Corrective Action



Synchronization is started.



Result of settings or user action. Normal.



Synchronization is completed.



Normal.



Synchronization is paused.



Synchronization paused because of user intervention, schedule or higher priority background activity.



Synchronization is resumed.



Synchronization has resumed again after a pause or a reboot.



Synchronization is stopped.



Synchronization stopped because of user intervention, schedule or the logical drive was deleted or went critical or offline.



Synchronization is aborted due to an internal error.



System resources are low. Reduce system load or restart the Avid VideoRAID SR. See “Restarting the Avid VideoRAID SR” on page 90.



Synchronization is queued.



Synchronization is already running on another logical drive in the same array.



Synchronization is stopped internally.



Synchronization stopped because the disk array was deleted or removed.



System Events Reported Event



Corrective Action



The system is started.



The Avid VideoRAID SR has been started.



The system is stopped.



The Avid VideoRAID SR was shut down.
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Disk Arrays: Critical and Rebuild Status



Disk Arrays: Critical and Rebuild Status The Avid fault-tolerant disk array goes critical when a disk drive is removed or fails. Due to the fault tolerance of the disk array, the data is still available and online. However, once the disk array goes critical, the disk array has lost its fault tolerance, and performance might be adversely affected. If the fault was caused by a failed drive that was removed, the drive must be replaced by another identical drive in order for the RAID system to rebuild and restore optimal configuration.



If a Physical Drive Fails Avid VideoRAID SR provides both audible and visual indicators to alert you of a disk drive failure. The following will occur when a disk drive fails or goes offline: •



The Logical Drive LED changes from green to amber. See “LEDs Display Amber or Red” on page 109.



•



The Disk Carrier Status LED changes from green to red. See “Drive Status Indicators” on page 110.



•



The audible alarm repeatedly sounds two short beeps. See “Avid VideoRAID SR is Beeping” on page 108.



•



the Avid Configuration Tool reports the condition. See “Avid Configuration Tool Reports a Problem” on page 113.



You must remove the failed drive and install an unconfigured replacement drive of the same type in the same slot as the failed drive. Until you install the replacement drive, the logical drive will remain Degraded. When the replacement drive has been installed, the Auto Rebuild function will begin to rebuild the disk array automatically as soon as you replace the failed drive.



n



If your replacement disk drive was formerly part of a different disk array or logical drive, you must clear the configuration data on the replacement drive before you use it. See “Clearing Stale and PFA Conditions” on page 41.
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4 Troubleshooting



Rebuild Operation During rebuild: •



The alarm sounds a single short beep, repeated



•



No warning icon displays over the Disk Array or Logical Drive in the Tree. Management View reports the Disk Array’s Operational Status as OK, Rebuilding.



•



The drive carrier holding the rebuilding physical drive displays a green Activity (lower) LED while the Status (upper) LED flashes green once per second.



Disk status



Power / Activity



During rebuilding, you can still read and write data to the logical drive. However, fault tolerance is lost until the Disk Array returns to OK (not-rebuilding) status. After a successful rebuild: •



The alarm is silent



•



The Disk Array’s Operational Status as OK



•



The rebuilt disk drive Status LED displays steady green.



Enclosure Problems the Avid Configuration Tool displays yellow exclamation points (!) or red Xs in Tree View to identify components that need attention. When a yellow ! appears over a Enclosure icon in Tree View, click the Enclosure icon. The Enclosure screen displays. In this example, a power supply has failed. The Enclosure Diagram displays color and motion changes to identify the failed power supply. In this case, you must replace the power supply. Note that the image above was shortened to fit on the page.
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Enclosure Problems



Overheating Overheating is a potentially serious condition because the excessively high temperatures can lead to disk drive failure and controller malfunction.



Overheating usually results from: •



Fan failure



•



Poor air circulation around the enclosure



The Avid Configuration Tool reports failed fans along with elevated temperature. On Avid VideoRAID SR, there are two kinds of fans: •



Power supply, 2 fans each



•



Cooling units, 1 fan each



If a power supply fan fails, you must replace the power supply. If a cooling unit fan fails, you can remove the cooling unit and replace only the fan itself.



No tools are required for either procedure.
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4 Troubleshooting



Air circulation around the Avid VideoRAID SR enclosure might be a more complex problem. Use the thermometer icons to help you locate the specific hot spot. Check for these conditions: •



Accumulated dust or objects blocking the fans



•



Less than a minimum of 5 inches (13 cm) space between the back of the Avid VideoRAID SR and the wall or other object



•



Ambient temperature above 95°F (35°C) where the Avid VideoRAID SR is operating



To cool down a Avid VideoRAID SR: 1. Correct any problems identified above 2. Power it down and let it sit for an hour or longer



Power Supplies The Avid VideoRAID SR is equipped with redundant power supplies. The advantage of dual power supplies is that, should one fail, the other will continue powering the enclosure until the faulty one can be replaced. Avid VideoRAID SR is capable of operating on a single power supply. As a result, if one power supply fails you must watch the front panel LEDs or the Avid Configuration Tool in order to become aware of the condition.



The power supplies are hot-swappable, meaning you can leave the Avid VideoRAID SR running when you replace the bad one. Be careful, however, to remove the faulty power supply and not the good one, or Avid VideoRAID SR will come to an immediate stop and your data will be unavailable until the system is powered and booted again. As noted above, if a power supply fan fails, you must replace the power supply. Without the fan to cool it, the power supply will overheat and eventually fail anyway. No tools are required for the procedure.
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Connection Problems



Connection Problems When you install your Avid product following the instructions in the Quick Start Guide and this Product Manual, you should have little trouble getting your equipment to work the first time. But connection problems can arise that are not the User's or Installer's fault. Every conceivable problem cannot be covered in the documentation but some guidelines could be helpful. Connection problems cause a majority of failures. While the installation of the cables and components might be correct, the following possibilities could occur: •



The connector gets dirty or corroded



•



The connector gets loose or damaged



•



The cable might look fine on the outside but has an open circuit inside



•



The wrong cable was used



Network Connection to Management Port The controller has an Ethernet (RJ45) Management Port connector on the back of the enclosure. This is a Gigabit Ethernet connector designed to connect to your network. The Avid VideoRAID SR becomes a node on your network like any other computer, server, or other network component with an IP address. Avid VideoRAID SR is configured by default to accept network configuration assignments from a DHCP server automatically. If you do not have DHCP enabled on your network, you will have to manually configure network settings. See “Accessing the Avid VideoRAID SR Configuration Tool” on page 55 for information about using the Avid Configuration tool. Connectivity LED



Mgmt



Activity LED



LED States LED



Dark



Amber



Green



Connectivity



10BaseT



1000BaseT



100BaseT



Activity



No activity



Flashing Green



Activity
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Browser Does Not Connect to the Avid Configuration Tool If you successfully setup and connected to the Avid Configuration Tool, then suddenly you can no longer connect, it might be the result of one or more of the following conditions if DHCP is enabled on your Avid VideoRAID SR’s virtual management port: •



The DHCP server does not have a dedicated IP address for the Avid VideoRAID SR



•



The Avid VideoRAID SR restarted and your DHCP server assigned a new IP address



You must obtain the new IP address in order to direct your browser to the Avid VideoRAID SR and start the Avid Configuration Tool. The easiest way to do this is to look at the Avid VideoRAID SR LCD panel, which displays the unit’s IP address.



Unsaved Data in the Controller Cache The Dirty Cache icon informs you that there is data in the cache that has not been saved to non-volatile memory. Such data is sometimes called “dirty,” not to suggest it is corrupted in some way but because it has not been saved to a disk drive.



115200 8N1



Status LED Dirty Cache LED



If there is unsaved data in the controller’s cache, the Dirty Cache LED shines amber. During this time, do NOT power down the Avid VideoRAID SR. Wait until the LED goes dark.
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A Specifications The following sections provide the dimensions and weight and the environmental, electrical, and power cord specifications for Avid VideoRAID SR. • Dimensions and Weight • Environment • Electrical



Dimensions and Weight The following table lists the dimensions and weight for Avid VideoRAID SR. Height



Width



Depth



Weight



5.3 in (13.5 cm)



17.6 in (44.6 cm)



22.1 in (56.1 cm)



84.9 lb (38.5 kg) with 16 drives installed



Environment The following table lists the environmental specifications for Avid VideoRAID SR. Temperature



Humidity



Vibration



5° to 40°C operational (-40° to 60°C non-operational)



Maximum 95 percent



Random, 0.21 grms, 5-500 Hz, 30 Mins, X, Y, Z axis



Electrical The following table lists the electrical specifications for the power supply in the VideoRAID SR arrays. The VideoRAID SR includes two power supplies; both power supplies are identical and you need to consider these requirements for each power supply. Power Supply



Voltage



Frequency



Current



Watts



Dual, hot swappable and redundant power supply



100–240 VAC (auto-ranging)



50–60 Hz (auto-ranging)



8 A @ 100 VAC with 566.95 W two power cords (maximum)



132



B Regulatory and Safety Notices Warnings and Cautions



c c c c c c



Never install equipment if it appears damaged. Disconnect the power cord before servicing unit. Only perform the services explicitly described in this document. For services or procedures not outlined in this document, speak with authorized Avid service personnel. Follow all warnings and cautions in the procedures. Operate the device within its marked electrical ratings and product usage instructions. If you need to replace a battery in an Avid hardware unit, be sure to use the correct battery type. There might be a risk of explosion if a battery is replaced by an incorrect type. Dispose of used batteries according to the manufacturer's instructions.



FCC Notice This device complies with Part 15 of the FCC Rules. Operation is subject to the following two conditions: 1. This device may not cause harmful interference. 2. This device must accept any interference received, including interference that may cause undesired operation. This equipment has been tested and found to comply with the limits for a Class A digital device, pursuant to Part 15 of the FCC Rules. These limits are designed to provide reasonable protection against harmful interference when the equipment is operated in a commercial environment. This equipment generates, uses, and can radiate radio frequency energy and, if not installed in accordance with the instruction manual, may cause harmful interference to radio communications. Operation of this equipment in a residential area is likely to cause harmful interference in which case the user will be required to correct the interference at his own expense.



Canadian ICES-003 This Class A digital apparatus meets all requirements of the Canadian Interference Causing Equipment Regulations. Cet appareil numérique de la classe A respecte toutes les exigences du Règlement sur le matériel brouilleur du Canada.



European Union Declaration of Conformity



Declaration of conformity Konformitätserklärung Déclaration de conformité Declaración de Confomidad Verklaring de overeenstemming Dichiarazione di conformità We/Wir/Nous/WIJ/Noi: Avid Technology 1925 Andover Street Tewksbury, MA, 01876 USA European Contact: Nearest Avid Sales and Service Office or Avid Technology International B.V. Sandyford Business Center Unit 3 Dublin 18, Ireland declare under our sole responsibility that the product, erklären, in alleniniger Verantwortung,daß dieses Produkt, déclarons sous notre seule responsabilité que le produit, declaramos, bajo nuestra sola responsabilidad, que el producto, verklaren onder onze verantwoordelijkheid, dat het product, dichiariamo sotto nostra unica responsabilità, che il prodotto,
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European Union Declaration of Conformity



Product Name(s):VideoRAID SR Model Number(s):7020-20256-XX Product Option(s): This declaration covers all options for the above product(s). to which this declaration relates is in conformity with the following standard(s) or other normative documents. auf das sich diese Erklärung bezieht, mit der/den folgenden Norm(en) oder Richtlinie(n) übereinstimmt. auquel se réfère cette déclaration est conforme à la (aux) norme(s) ou au(x) document(s) normatif(s). al que se refiere esta declaración es conforme a la(s) norma(s) u otro(s) documento(s) normativo(s). waarnaar deze verklaring verwijst, aan de volende norm(en) of richtlijn(en) beantwoordt. a cui si riferisce questa dichiarazione è conforme alla/e seguente/i norma/o documento/i normativo/i. The requirements of the European Council: Safety: Directive 2006/95/EEC UL 60950-1, 2nd edition (2007) CAN/CSA-C22.2 No. 60950-1-07 IEC 60950-1,2nd edition, 2005-12 EN 60950-1: 2006 EMC: Directive 93/68/EEC EN55022:2006 EN55024:1998 /A1:2001 /A2:2003 EN61000-3-2:2000 /A2:2005 EN60000-3-3:1995 /A1:2001 /A2:2005 November 19, 2008 Gerrett Durling, Director Hardware Engineering
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Disposal of Waste Equipment by Users in the European Union This symbol on the product or its packaging indicates that this product must not be disposed of with other waste. Instead, it is your responsibility to dispose of your waste equipment by handing it over to a designated collection point for the recycling of waste electrical and electronic equipment. The separate collection and recycling of your waste equipment at the time of disposal will help conserve natural resources and ensure that it is recycled in a manner that protects human health and the environment. For more information about where you can drop off your waste equipment for recycling, please contact your local city recycling office or the dealer from whom you purchased the product.



Australia and New Zealand EMC Regulations



Nigel Streatfield General Manager Avid Technology (Australia Unit B 5 Skyline Place French Forest NSW 2086 Australia Phone: 61-2-8977-4800



Taiwan EMC Regulations Taiwan EMC Regulations BSMI Class A EMC Warning



136



Index



A Adapter board 27 Alarm cancel 96 sounds 108, 125 Alarm, cancel 96 Alias subsystem 73 Australia EMC regulations 136 Auto Fix 78, 103 Auto Rebuild function 125 Avid Configuration tool Event Frame 61 Header 59 interface 58 language selection 57 log in 55 Management View 60 no browser connection 130 problem reporting 113, 125 Tree View 60 username and password 56 Avid VideoRAID SR disk management 42 shipping kit contents 23



B Background activities deleting schedule 78 list of scheduled 77 scheduling 77 view 77 BBU, reported events 116 Blower, reported events 115, 116



Browser, does not connect 130 Buzzer settings 96 silence 96 sounding 108, 125 test 97



C Cable signal strength 53 Canadian interference causing equipment regulations 134 Cancel alarm 96, 96 Check table, logical drive 103 Clear statistics 91 Configuration script, import 88 Configuration status, physical drive 98 Connection DHCP 23 management port 22 serial 62, 64 Connections problems 129 SAS 34 Connector, RJ45 129 Controller heartbeat LED 35, 109 information 92 locate 92 reported events 116, 118 status LED 112 view 92 Cooling unit LED 111 status 95 Create user 82



Index



D DAS SAS 53 Data connector SAS 34 Date and time, subsystem 74 Delete user 83 Deleting schedule, background activities 78 DHCP (Dynamic Host Configuration Protocol) 23, 55 DHCP server changed IP address 130 Dirty cache LED 112 Discover button 72 Disk array critical 125 manual rebuild 101 offline 125 rebuild 100, 126 view 99 Disk drive installing 31 Disk status LED 94, 110, 125, 126 Download firmware image file 89



E Email service 86 settings 85 test message 81, 86 Email messages 113 Enclosure information 95 locate 93 overheat 127 reported events 117 settings 95 temperature 95 topology 94 view 93 voltage 95 European Union notice 134 Event notification response 114 severity 81 138



subscriptions 80 Event log clear 75, 77 problem reporting 113 reported events 117 runtime 74 save 75, 76 ExpressStripe 47



F Failed power supply 126, 128 power supply fan 127 Failure recovery, physical drive 125 FCC notice 133 Firmware image file, download 89 Firmware update from PC 89 WebPAM PROe 89 FRU LED 35, 109 status LED 111 VPD 96



G Global setting 52



H H380 controller 27 Heartbeat LED 35, 109 HyperTerminal 64



I Import configuration script 88 Inconsistent block table 104 Information controller 92 enclosure 95 FRU VPD 96 logical drive 101, 105 physical drive 98 subsystem 73 Installing disk drives 31



Index



IP address DHCP server changed 130 management port 56



L Language selection, Avid Configuration tool 57 LCD Panel attaching 27 LCD panel 22 LED controller 35, 109 controller status 92, 112 cooling unit 111 dirty cache 92, 112 disk status 94, 110, 125, 126, 126, 126 Ethernet connector 129 fan 111 FRU 35 logical drive LED 109 FRU status 111 heartbeat 35, 109 logical drive 35, 109, 125 power 35, 109 power supply 111 power/activity 110 red or amber 109 RJ45 connector 129 Locate controller 92 enclosure 93 physical drive 98, 98 power supply 95 Log in Avid Configuration tool 55 Log out WebPAM PROe 62 Logical drive check table 103 information 101, 105 LED 35, 125 Redundancy Check 102 reported events 118, 119 Summary 104 view list of all 104 Logout other users 84



M MAC address 56 Macintosh host bus adapter 27 operating system 27 Macintosh setting 52 Management connection SAS 34 Management port 22, 23 Media Patrol reported events 119, 120



N Narrow port 52 New Zealand EMC regulations 136 No network message 22



O Online help WebPAM PROe 59 Operating system 52 Overheated enclosure 127



P Password Avid Configuration tool 56 WebPAM PROe 81 Pause On Error 78, 103 PFA condition 99 Physical drive configurational status 98 failure recovery 125 information 98 installing 31 list 97 locate 98, 98 operational status 98 reported events 120 stale and PFA condition 99 statistics 98 Popup messages 113 Power LED 35, 109 139



Index



Power supply failed 126, 128 fan failure 127 LED 111 locate 95 reported events 121 status 95 Power supply fan reported events 121 Power/activity LED 110 Problem reporting Avid Configuration tool 113, 125



R Rackmount VideoRAID SR 30 Read check table 104 Rebuild disk array 100, 126 manual 101 reported events 122 Red X 108, 113, 126 Redundancy Check 78, 102 reported events 123 Regulatory information 133 Reported events BBU 116 blower 115, 116 controller 116, 118 enclosure 117 event log 117 logical drive 118, 119 Media Patrol 119, 120 physical drive 120 power supply 121 power supply fan 121 rebuild 122, 122 Redundancy Check 123 resource not available 123 SMART error 123 synchronization 124 system 124 Resource not available reported event 123 RJ45 connector 129 Runtime event log 74



140



S Safety information 133 SAS DAS 53 data connection 34 management connection 34 signal strength 53 SAS Management cable signal strength 53 global 52 Scheduling background activities 77 Serial connection 62, 64 Setting global 52 Settings buzzer 96 email 85 enclosure 95 SLP 87 subsystem management port 85 temperature 95 user 79, 80 Web Server 87 Setup DHCP 23 Severity of events 81 SLP service 87 settings 87 SMART error 123 Software Services 85 Stale condition 99 Statistics clear 91 physical drive 98 Status controller 92 cooling unit 95 physical drive 98 power supply 95 Storage Network 71 Subsystem alias 73 date and time 74 information 73 logging into 72



Index



management port settings 85 service report, save as text file 73 storage network 71 Switch operating systems 52 Synchronization reported events 124 System initializing 22 System reported event 124



T Taiwan EMC regulations 136 Telnet 64 Temperature thresholds 95 Temperature, enclosure 95 Test buzzer 97 email 81, 86 Topology enclosure 94



U Unpacking the VideoRAID SR 23 User create 82 delete 83 event subscriptions 80 logout others 84 password, change 81 settings 79, 80 view 79 view sessions 84 Username and password Avid Configuration tool 56 using ExpressStripe 47 Using the disk management utility 42



View background activities 77 controllers 92 disk arrays 99 enclosure 93 list of all logical drives 104 physical drives 97 scheduled activities 77 users 79 Virtual management port 85, 130 Voltage, enclosure 95



W Web Server service 88 settings 87 WebPAM PROe log out 62 Windows setting 52 Write check table 104



Y Yellow ! 108, 113, 126



V VideoRAID SR beeping 108, 125 features and benefits 17 rackmount VideoRAID SR 30 unpacking 23, 23



141



Index



142



























[image: Avid VideoRAID SR Setup and User Guide - Avid DS Support Center]
Avid VideoRAID SR Setup and User Guide - Avid DS Support Center












[image: AVID Path]
AVID Path












[image: AVID Tutor Expectations.pdf]
AVID Tutor Expectations.pdf












[image: AVID Tutorial Form.pdf]
AVID Tutorial Form.pdf












[image: AVID Community Service]
AVID Community Service












[image: AVID Console Commands - Sound & More]
AVID Console Commands - Sound & More












[image: GHHS AVID application.pdf]
GHHS AVID application.pdf












[image: AVID Console Commands - Sound & More]
AVID Console Commands - Sound & More












[image: AVID Newsletter Vol XXIV.compressed.pdf]
AVID Newsletter Vol XXIV.compressed.pdf












[image: avid sibelius 7.pdf]
avid sibelius 7.pdf












[image: AVID 11th Grade Syllabus.pdf]
AVID 11th Grade Syllabus.pdf












[image: avid media composer tutorials pdf]
avid media composer tutorials pdf












[image: AVID Newsletter Vol XXII.compressed.pdf]
AVID Newsletter Vol XXII.compressed.pdf












[image: GHHS AVID info .pdf]
GHHS AVID info .pdf












[image: AVID 10th Grade Syllabus.pdf]
AVID 10th Grade Syllabus.pdf












[image: AVID Application Form 2014.pdf]
AVID Application Form 2014.pdf












[image: [READ] PDF Avid Agility: Working Faster and More ...]
[READ] PDF Avid Agility: Working Faster and More ...















Avid VideoRAID SR Setup and User Guide - Avid DS Support Center






Nov 19, 2008 - The software may not be reverse assembled and may be used or copied only in accordance with the terms of the .... Open Media Framework, Open Media Management, PCTV, Pinnacle MediaSuite, Pinnacle Studio, Pinnacle Systems,. ProEncode .... Updating Firmware (BIOS) and LSI Drivers (HP xw8400) . 






 Download PDF 



















 4MB Sizes
 14 Downloads
 187 Views








 Report























Recommend Documents







[image: alt]





Avid VideoRAID SR Setup and User Guide - Avid DS Support Center 

Nov 19, 2008 - The requirements of the European Council: Safety: Directive 2006/95/EEC. UL 60950-1, 2nd edition (2007). CAN/CSA-C22.2 No. 60950-1-07. IEC 60950-1,2nd edition, 2005-12. EN 60950-1: 2006. EMC: Directive 93/68/EEC. EN55022:2006. EN55024:














[image: alt]





AVID Path 

Tutor. T utor/Student. T utor/Student. T ime Frame. 30 minutes. 30 minutes. 45 minutes. 60 minutes. 60 minutes. 20 minutes. 20 minutes. 60 minutes. 20 minutes.














[image: alt]





AVID Tutor Expectations.pdf 

There was a problem previewing this document. Retrying... Download. Connect more apps... Try one of the apps below to open or edit this item. AVID Tutor ...














[image: alt]





AVID Tutorial Form.pdf 

Page 2 of 2. AVID Tutorial Form.pdf. AVID Tutorial Form.pdf. Open. Extract. Open with. Sign In. Main menu. Displaying AVID Tutorial Form.pdf. Page 1 of 2.














[image: alt]





AVID Community Service 

Contributing positively to a community and gaining a sense of service to that community. Requirements: 1. You must complete 40 hours of community service before the completion of this academic year. a. 20 hours in each semester b. Any hours that were














[image: alt]





AVID Console Commands - Sound & More 

Nov 18, 2007 - Picture in Picture, or automatically by the system when you place an SD .... space, and know if they have time for a phone call or a long lunchâ€¦














[image: alt]





GHHS AVID application.pdf 

parents have less than a four- year college degree. (AVID Center 2007-2008). Page 2 of 2. GHHS AVI ... tion.pdf. GHHS AVI ... tion.pdf. Open. Extract. Open with.














[image: alt]





AVID Console Commands - Sound & More 

Nov 18, 2007 - resulting in a speedup of course. .... BackRevCC -- Copy sequence for Symphony Meridien CC .... AVID and Adobe Training for Television.














[image: alt]





AVID Newsletter Vol XXIV.compressed.pdf 

that I would need to uselaterin life. â€� Min Ji Cha. Here's my. adviceto. every student. Don'tcome. to school. thinkingit's just seven hours of. ignoringtheteacher ...














[image: alt]





avid sibelius 7.pdf 

There was a problem loading more pages. avid sibelius 7.pdf. avid sibelius 7.pdf. Open. Extract. Open with. Sign In. Main menu. Displaying avid sibelius 7.pdf.














[image: alt]





AVID 11th Grade Syllabus.pdf 

Page 1 of 2. 11th Grade AVID: Advancement Via Individual Determination. 2016 â€“ 2017 COURSE SYLLABUS. General Description: Major Concepts/Content: Advancement Via Individual Determination (AVID) is an academic elective course that. prepares students














[image: alt]





avid media composer tutorials pdf 

There was a problem previewing this document. Retrying... Download. Connect more apps... Try one of the apps below to open or edit this item. avid media ...














[image: alt]





AVID Newsletter Vol XXII.compressed.pdf 

Page 1 of 2. Important Dates: December. 21 â€� End of 2nd. Quarter. 22 â€� College Logo. Painting. January. 6 â€� Teacher Workday,. No School. 9 â€� Professional.














[image: alt]





GHHS AVID info .pdf 

AVID Activities: Learning with college tutors through tutorials Writing for all classes Developing success strategies Applying for four-year university admissions, scholarships, and financial aid. Visiting college campuses Interacting with college an














[image: alt]





AVID 10th Grade Syllabus.pdf 

There was a problem previewing this document. Retrying... Download. Connect more apps... Try one of the apps below to open or edit this item. AVID 10th ...














[image: alt]





AVID Application Form 2014.pdf 

Page 1 of 2. 1 of 2. Carlsbad High School AVID Application. Advancement Via Individual Determination. An Academic College Preparatory Program. Students interested in participating in the Carlsbad High School AVID college preparatory program must comp














[image: alt]





[READ] PDF Avid Agility: Working Faster and More ... 

Book Synopsis. THE ULTIMATE BOOK ON. HARNESSING THE POWER OF. AVID MEDIA COMPOSER. Filled with hundreds of techniques and profusely illustrated in color, it will help you discover new ways to use the system and do things you didn t know were possible


























×
Report Avid VideoRAID SR Setup and User Guide - Avid DS Support Center





Your name




Email




Reason
-Select Reason-
Pornographic
Defamatory
Illegal/Unlawful
Spam
Other Terms Of Service Violation
File a copyright complaint





Description















Close
Save changes















×
Sign In






Email




Password







 Remember Password 
Forgot Password?




Sign In



















Information

	About Us
	Privacy Policy
	Terms and Service
	Copyright
	Contact Us





Follow us

	

 Facebook


	

 Twitter


	

 Google Plus







Newsletter























Copyright © 2024 P.PDFKUL.COM. All rights reserved.
















